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Koala License Agreement
Important
This legal document is an agreement between you, the user, and Koala
Technologies Corp. By opening the disk packaging you are agreeing to becoml·
bound by the terms of this agreement which includes the program license, hardwa11·
limited warranty, and the disclaimer of warranty.
This agreement constitutes the complete agreement between you, the user of this
product, and Koala Technologies. If you do not agree to the terms of this License
Agreement, do not open the disk packaging. Promptly return the unopened disk
package, manuals, and hardware to the place you purchased them for a full refund.

Program License
In consideration of the payment of the License fee, which is a part of the price you
paid for this product, Koala Technologies as Licensor grants to you, the Licensee, a
nonexclusive right to use this copy of a Koala software program (the Program) on
one single-user computer system.
Koala Technologies remains the sole owner of this Program. This License is not a
sale of the original Program or any copy thereof. As the licensee you own the
magnetic or other physical media on which the program is recorded, however,
Koala Technologies retains the title and ownership of the Program recorded on the
original disks and all subsequent copies of those disks.
You may not rent, sell, loan or otherwise transfer the program to anyone else unless
you permanently transfer all copies of the Program in your possession and the new
owner notifies Koala Technologies in writing of the transfer and accepts the terms of
the License Agreement.
This License Agreement remains in effect until you return the Program to Koala
Technologies, properly transfer it to a new owner or destroy all copies of the
Program in your possession. Koala Technologies may terminate this License
Agreement at any time without notice if you breach any of its terms. Koala
Technologies reserves all rights not expressly granted to the Licensee.

Copyright And Program Use Restrictions
The Program and its accompanying manual are copyrighted by Koala Technologit''
You may not make copies of the Program except as permitted by the License
Agreement. You may not make unauthorized copies of the Program or manual f( 11
any reason.
Under the terms of this agreement you may make one (1) copy of the Program f< ir
backup purposes. You must reproduce and include the copyright notice on the
backup copy. Making copies of the manual is prohibited by this Agreement. You
may not modify, decompile, disassemble, or reverse-engineer the Program.
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As the Licensee you may physically transfer the Program from one computer to
another provided that the Program is used on only one computer at a time. You
many not electronically transfer the Program from one computer to another over a
network of any type. You may not distribute copies of the Program or its manual to
others using any physical or electronic form or means.

Update Policy
From time to time, Koala Technologies may create updated versions of the Program.
At its option, Koala may make such updates available to Licensees or transferees
who have returned the Product Registration Card to Koala and paid the update fee.

Limited Warranty
This Koala product, including the disk(s) on which the software program is
supplied, is warranted against manufacturing defects in materials and workmanship
for ninety (90) days from the date of purchase by the original user. This warranty is
limited to ninety (90) days, applies only to the original user, and is not transferrahle.
Koala makes no other express warranties on the product.
Koala Technologies will repair or replace this product (at our option) if it is
found defective in materials or workmanship within ninety (90) days of
purchase by the original registered purchaser. Tampering, abuse or
unauthorized repairs void this warranty. Should your unit be defective,
contact Koala Technologies Customer Support.
Koala's entire liability and your exclusive remedy as to the hardware or disk(s) shall
be, at the option of Koala, either to refund the purchase price or to replace the
hardware or disk(s) that do not meet Koala's limited warranty and which have been
returned to Koala with a copy of the purchase receipt. If failure of the hardware or
disks is due to accident, abuse or misapplication, Koala shall have no responsibility
to replace the hardware or disk(s) or refund the purchase price.
This limited warranty gives you specific legal rights, and you may also have other
legal rights which vary from state to state.
This limited warranty on Koala Technologies products is valid only in the United
States of America. If you reside outside the USA, Koala provides this product "as is"
without warranty of any kind. You should contact your local Koala Technologies
sales representative or dealer for warranty information for your country.

Limitation Of Liability
In no event shall Koala, its authorized dealers and distributors or anyone else who
has been involved in the creation, production or delivery of this product, be liable
for any direct, indirect, incidental, special or consequential damages, such as, hut
not limited to, loss of anticipated profits or benefits resulting from the use of this
product or any breach of any warranty, even if Koala or its authorized dealer or
distributor has been advised of the possibility of such damages. In no event will
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Koala's or its authorized dealers or distributors liability exceed the price paid 1111 111·
product.
Koala Technologies does not warrant, guarantee or make any representations
regarding the use, or the results of the use of the hardware software or written
instructions as to correctness, accuracy, reliability or suitability for a particular
purpose.
The entire risk as to the results achieved by the use of the hardware and softwa1r '"
assumed by you. You assume responsibility for the selection of the product to
achieve your intended results, and for the installation, use, and results obtained In 1111
the product.
Some states do not allow the exclusion or limitation of incidental or consequential
damages, so the above exclusions or limitations may not apply to you.
This License Agreement, Limited Warranty and Disclaimer of Warranty is governl'd
by the laws of the State of California. Should you have any questions concerning tl11"
Agreement you may contact Koala Technologies by writing to: Koala Technologil·.,,
Customer Service and Support, 70 N. Second Street, Sanjose, CA 95113.

Copyright Considerations When Using MacVision
With MacVision it is possible to make images of two dimensional objects such as
maps, charts, posters or photographs as well as three dimensional objects of all
sizes. MacVision can also be used to digitize images contained on video tapes or
laser disks.
As you make digitized images of documents, video frames, and objects, keep in
mind that many of these are covered by copyrights owned by their originators or
publishers and are protected by the U.S. copyright laws. Under this law, the
copyright owner not only has the exclusive right to make and distribute copies of
the work, hut also has the exclusive right to prepare derivative works based on till'
original work.
Preparation of a derivative work by using MacVision to make a digitized image of a11
object and then change shading or gray scale, move or delete parts of the imagl', 111
use the original image as a component in a new image without the express
permission of the copyright owner constitutes copyright infringement. If you arl'
found to he infringing a copyright, the copyright owner can have your work
removed from production and distribution. You can also he required to pay
damages as well as legal fees arising from the copyright enforcement action.
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Be sure to determine whether materials you are digitizing with MacVision are
covered by a copyright or are in the public domain. Many old documents, images
and objects are now in the public domain due to actions of their copyright holders
or the expiration of the original copyright. Always check to determine the copyright
status of any documents or objects you use to make MacVision images.
Whenever you use MacVision to digitize copyrighted work, the safest procedure is
to obtain the express permission of the copyright owner or their designated
representative. Just as you would not like others to make use of your work without
permission, please show respect for the property rights of others.

Federal Communications Commission
Radio Frequency Interference Statement
"This equipment generates and uses radio frequency energy and if not installed and
used properly, that is, in accordance with the manufacturer's instructions, may cause
interference to radio and television reception. It has been type tested and found to
comply with the limits for a Class B comounting device in accordance with the
specification in Subpart] of Part 15 of FCC Rules, which are designed to provide
reasonable protection such interference will not occur in a particular installation. If
this equipment does cause interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to
correct the interference by one or more of the following measures:
reorient the receiving antenna
relocate the computer with respect to the receiver
4
move the computer away from the receiver
4
plug the computer into a different outlet so that the computer and receiver are
on different circuits.
If necessary, the user should consult the dealer or an experienced radio/television
technician for additional suggestions.
The user may find the following booklet prepared by the Federal Communications
Commission helpful: 'How to Identify and Resolve Radio-TV Interference Problems.·
This booklet is available from the U.S. Government Printing Office, Washington,
D.C., 20402. Stock No. 004-000-0035-4"
4
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Chapter 1

Introduction

Welcome
Congratulations on your purchase of MacVision, the original
video digitizer for the Macintosh. With MacVision and a video
camera you can capture images from the real world and use
them in Macintosh documents, including your desktop
puhlishing, multimedia presentations or HyperCard stacks.
Whether you are a heginner or an expert, you'll find
MacVision's simplicity and ease of use lets you produce
creative and highly professional images. You can print these
images on non-Postscript printers or Postscript laser printers
or high-resolution typesetters. And you can quickly and easily
experiment with a wide range of lighting, composition and
special effects.
Note: This manual assumes you know the hasics ahout using

a Macintosh computer. If you are unfamiliar with opening
icons, selecting buttons, using pull-down menus and sizing
windows, read your Macintosh system software manual or
take the Macintosh Guided Tour hefore you continue.
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MacVision Overview
MacVision captures video images using a combination of
hardware and software. The MacVision hardware is an
external video digitizer with composite video input and serial
data output. The digitizer connects to a Macintosh's modem or
printer port and converts analog information from a video
signal source to digital information that your computer can
process. This video signal source can be any NTSC output (or
PAL output with the proper hardware.)
MacVision lets you optimize the scanning process to suit
individual tastes. You do this by adjusting the contrast and
brightness with two large knobs on top of the digitizer. To
help you adjust these controls properly, MacVision provides a
real-time center column graph display of the image's gray
values.
You can preview an image using Pre•Views. Pre•Views
repeatedly updates an image to make it easy for you to see
exactly what you'll be scanning- before you start.
After you digitize an image, MacVision holds it in memory and
displays the image in a window from where you can modify,
store or print it. A digitized image is composed of an array of
pixels, or tiny dots, with 8 bits of grayscale resolution per
pixel (8-bits gives you 256 shades of gray).
You can crop, enhance and save a MacVision image in one of
several file formats such as RIFF, TIFF, EPSF, PICT, PICT2 and
MacPaint. MacVision can import RIFF and TIFF files. For more
information on file formats, see Appendix E, File Formats. For
more information on how MacVision works, see Appendix A,
How Mac Vision Works.
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What You Need Before Starting
To use MacVision, you need:
.A.

NTSC (RS-170 or RS-170A compatible) composite video
source. Some examples are camcorders or cameras, still
video cameras, VCRs (four heads/freeze frame) or laser
disk players.
Note: The key to obtaining superior MacVision images is

to use a high-quality video camera that is NTSC RS-170 or
RS-170A compatible. If you have a choice, use a black &
white rather than a color camera. With color cameras,
images may have patterns that cannot be completely
removed. When using still cameras, use one with "full
frame" capabilities .
.A.

Video coaxial cable terminated with a male RCA plug at
one end for the MacVision digitizer. At the other end, the
cable should have a connector that is compatible with your
video equipment's "video out" port .

.A.

Any of the Macintosh family of computers: Macintosh Plus,
SE, SE/30, II, Ilx, Hex Ilci, or Macintosh Portable .

.A.

Macintosh System 6.0.2 or later.

.A.

Minimum one megabyte of memory - two megabytes is
recommended .

.A.

Hard disk is optional, but recommended for image storage.
Storage estimate: three or four images per megabyte.

Note: If you have an older version of the Macintosh system

software, we suggest you contact your authorized Apple
dealer to obtain a later version.

Introduction
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Macintosh Hardware Considerations
Macintosh Monitors
You can view 256 shades of gray on a:
&

Macintosh II series computer with an 8-, 24- or 32-bit vic.lc< >
card and a monochrome or color monitor.

&

Macintosh SE/30 with a grayscale or color video card and
monitor.

With a standard Macintosh Portable, Plus, SE or SE/30, the
screen displays a one-bit black and white image.

Macintosh Printers
MacVision can print images on Postscript-compatible printers
or typesetters. You can also print MacVision images using
non-Postscript printers.

Multi Finder
MacVision is compatible with current versions of the
Macintosh System, Finder and MultiFinder. When used with
MultiFinder, you must nm MacVision in the foreground while
scanning. You can run other MacVision operations such as
printing as background tasks.
If you encounter a Not Enough Memory message while using
MacVision under MultiFinder, you may be able to increase the
application's memory size on the Get Info dialog box. See
your Macintosh system software manual for instructions.

-
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AppleTalk Networks
Some AppleTalk networks such as AppleShare or Tops must
be turned off before scanning images with MacVision. A
handy way to do this is with an NB switch. For more
information, see Appendix G, Troubleshooting. If you want to
edit or print MacVision images, leave the network turned on.

Product Contents
You should find the following items in your MacVision
package:
.&

MacVision digitizer with cable

.&

External power supply

.&

Program disk

.&

MacVision User's Manual

How to Use This Manual
This manual contains the following chapters:

Chapter 1 Introduction gives an overview of how MacVision
digitizes video images. It also lists what you need to use
MacVision, what the product includes, how it interacts with
other applications and hardware and how to use this manual.
Chapter 2 Getting Started shows you how to set up the
MacVision hardware and software. It tells you how to start the
application and select important video input settings.
Chapter 3 Using Mac Vision includes procedures that walk you
through tasks you can perform with MacVision. If you're new
to the Macintosh or MacVision, be sure to look through this
chapter.

Introduction
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Chapter 4 Reference contains alphabetical topics for menus,
tools and windows. The commands on each menu are listed
in the order they appear on that menu. After you become
comfortable using the Macintosh and MacVision, use this
chapter to look up items of interest.
Appendixes offer detailed information about how MacVision
works; tips on selecting a camera and lighting; background
about halftones, grayscale and bitmaps; descriptions of
various file formats; MacVision specifications; and
troubleshooting instructions.
A Glossary and Index are included at the end of this manual to
explain important terms and to help you find information
quickly.
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Chapter 2

Getting Started
This chapter takes you through the simple steps for installing
and starting MacVision for the first time. Whether you're a
new or experienced Macintosh user, he sure to read this
chapter while you set up MacVision.

Installing the MacVision Hardware
1.

Connect the RCA male plug of a video coaxial cahle into
the MacVision digitizer.

2.

Connect the other end of the video cahle into your video
source's "video out" jack.

3.

Connect the round DIN connector on the digitizer serial
cahle into the Macintosh modem or printer port.

4.

Plug the digitizer power module into the digitizer and
then an AC outlet.

Note: Be sure to use a video-quality cable rather than an
audio cahle for connecting the camera to the digitizer. Signal
loss and distortion produced by lower quality audio cables
will degrade the image. Cahle lengths exceeding 20 feet can
also reduce the image quality. Good quality video cables and
adapters are availahle from most video and electronics
dealers.

Getting Started
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If your video source does not have a built-in viewfinder, you
can view the video output with a television monitor
connected to the video output cable using a "T" or "Y"
connector.

Installing MacVision Software
1.

Create a new folder on your hard disk called "MacVision".

2.

Copy the files from the MacVision program disk to the
new folder.

The MacVision program disk contains the application and a
sample image file. You can install MacVision on a hard disk or
run it from a copy of the original disk if you prefer. Be sure to
put the original MacVision disk in a safe place.
For information on initializing disks or copying files, refer to
your Macintosh system software manual.

Memory Requirements
If your Macintosh computer has 2MB or more of Random
Access Memory (RAM), you can use MacVision with
MultiFinder. Hyour computer has lMB of memory, you
must use MacVision with the Finder.
If you decide to use MacVision with MultiFinder, you should
specify the amount of RAM before launching the application.
Do this by clicking the application icon once and choosing
Get Info from the File menu. At the bottom of the Get Info
dialog box, the suggested (minimum) memory size and the
current application memory size appear. You can change the
current application memory size.
MacVision requires 900K in RAM-1,SOOK is recommended.
By increasing the application memory size, you will be able to
open more windows and images while running MacVision .
.
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Starting MacVision
1.

Turn on the power to the MacVision digitizer and the
video source.

2.

Choose Control Panel from the Apple menu and click
the Monitor icon to verify that your Macintosh monitor is
set to the preferred number of gray levels.

3.

Double click the MacVision icon to launch the
application.
MacVision checks for the proper version of the System
and ROM. If the system cannot support the application,
MacVision displays a message to let you know.

Getting Help
1.

Choose Help from the Apple menu.
Or:
Press the Command-? shortcut keys.
The MacVision Help dialog box appears with a pop-up
menu at the top that lists the available topics.

2.

Choose a topic from the pop-up menu.
The middle of the Help dialog box displays a Help panel
containing an explanation for the topic you chose. If you
choose another topic from the pop-up menu, the Help
panel is updated to give you new information.

3.

Click OK when you finish viewing help information.

Getting Started
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Enable/Disable Watchdog
.6.

Choose the Enable Watchdog or Disable Watchdog
command from the Video menu.
If this toggle command displays Enable Watchdog, the
Watchdog command is turned off. If this command
displays Disable Watchdog, the Watchdog command is
turned on.

When the Watchdog command is turned on, it instantly
tells you if MacVision becomes unlinked from your video
input device. For instance, if the video is turned off or if
cables come loose or disconnected. It does this by
repeating the System alert sound and flashing the video
menu title to warn you.
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Chapter 3

This chapter contains step-by-step procedures to help you
quickly start using MacVision.
Before starting this chapter, you should be familiar with the
basics of using the Macintosh. Also, you should have already
installed MacVision. For more information about installing and
starting Mac Vision see Chapter 2, Getting Starled.

Selecting Video Input Options
1.

Choose Input Options from the Video menu.

2.

Verify that the input options match your video and
Macintosh environment and the desired input quality.
The serial port is initially set to Modem; if you have
connected the digitizer to the printer port, select Printer.
The video standard is initially set to NTSC (the system
used in the U.S., Japan, and most of North and South
America). If your video equipment uses PAL (the system
used in Europe and other countries), select PAL.
For more information about these input options, see
Chapter 4, Reference.

Using MacVision
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Using Pre• Views
Adjusting B & C (Brightness and Contrast)
1.

Turn on any lights and follow your video system
instructions to set the lens and adjust the controls. For
more information about lighting, see Appendix C, Tips on
Lighting

2.

Choose Pre•Views from the Video menu.
Adjust B & C is the default option selected on the
Pre•Views dialog box. It displays a continuously updated
bar chart that shows gray values sampled from the video
image. MacVision samples a column down the middle of
the video frame.
If you are using a video camera, you can get an intuitive
feel for how this feature works by moving your hand in
front of the camera lens while watching the levels of gray
change on the bar chart.

3.

Examine the gray values on the bar chart to determine
whether to adjust the brightness.

4.

Turn the recessed Brightness knob on top of the
MacVision digitizer clockwise to increase the brightness
or counterclockwise to decrease it. You will see the
brightness changes as you turn the knob.
Don't force the rotation of the knobs since this can
damage the digitizer.
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A djust B & C

Qulck View

@]
Focus Zoom 2 :1

~

Focus Zoom 4 :1

OK

Figure 3-1 7be Adjust B & C Graph.
5.

Compare the distance between black and white lines on
the bar chart to decide whether to adjust the contrast.
If the ends of the black and white lines are far apart, the
contrast is high in the image sample. If the ends of the
black and white lines are close together, the contrast is
low.

6.

Turn the Contrast knob on top of the Mac Vision digitizer
clockwise to increase the contrast or counterclockwise to
decrease it.

Note: To put the Brightness and Contrast in the middle, turn

the knob until the outer edge of its fingertip-shaped
indentation points toward the raised plastic letters that spell
the word: Brightness or Contrast.
For more information about adjusting the brightness and
contrast, see the Video Pre• Views topic in Chapter 4,
Reference.

Using MacVision
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Previewing with Quick View
1.

Choose Pre•Views from the Video menu.

2.

Click Quick View.

~

Ady.J:::t E:

.:?.._

C

ii
@]
FO(:IJS Zoom 2 1

[Q
Focu:.:: Z(•Offl 4_1

OK

Fip,ure 3-2 1be Pre• Views dialop, hox.
The Pre•Views dialog box displays a real-time,
low-resolution preview of the digitized video image. Usl·
Quick View to quickly check the lighting, brightness and
contrast settings.
Quick View, like Adjust B & C, continuously updates thl'
information it displays. As you make changes with the
Brightness and Contrast knobs, you immediately see a
change in the Quick View display.
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Focus Zoom 2:1
1.

Choose Pre•Views from the Video menu.

2.

Click Quick View.

3.

Drag the focus box to any part of the image if you want to
select a different area.

4.

Click Focus Zoom 2:1.

~

Adjust B & C

~

Quick View

II

Focus Zoom 2 :1

Focus Zoom 4:1

OK

Figure 3-3 The Focus Zoom 2: 1 dialog box.

The Focus Zoom 2: 1 area displays a preview of the
digitized video image inside the focus box.

Using MacVision
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Focus Zoom 4:1
1.

Choose Pre•Views from the Video menu.

2.

Click Quick View.

3.

Drag the focus box to any part of the image if you want t• •
select a different area.

4.

Click Focus Zoom 4:1.
Column

~

Adjust B & C

Qufok v;ew

@]
F'ocus Zoom 2 :1

[II
Focus Zoom 4 :1

OK

Figure 3-4 1be Focus Zoom 4: 1 dialog box.

The Focus Zoom 4:1 area displays a close-up view of the
digitized video image that you can use to focus the image.

Scanning an Image
1.

Choose New from the File menu.

2.

Select a Capture Mode and Pixel Depth.
The default choices are Normal and 8-bit (256 grays),
respectively.

3.
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Select Digitizing Options.
C8pture Mode: I Norm81
PiHel Depth:

I~::::;:::::;:;:::::::~
8-Bit (256 Gr8ys) I

[ C8ncel J

~

OK

D

Figure 3-5 The New dialog box.

Digitizing lm8ge ...

Press "Esc" or" i!!i ."To Abort.

Figure 3-6 Scanning Progress message box.
MacVision displays a message box with a horizontal bar
that fills up with black to show you how the scan is
progressing.
You may cancel the scan at any time while it
progresses by pressing Esc or Command-Period.
The time this process takes varies depending upon your
Capture Mode choice. When the scan is complete, the
new image displays in the MacVision window. You can
modify this image using commands on the MacVision
Edit, Style or Graymap menus. You can also save the
image for use with other applications.
Note: If the resulting image is distorted, you can use the Swap
Fields command to correct it. For more information about
swapping fields, see Chapter 4, Reference.
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Saving an Image
1.

Choose Save or Save As from the File menu.

2.

Select the file format, pixel depth, compression and byll"
ordering options you prefer.

3.

Type a name for this image file.

4.

Click Save.

la Rrchiue MacUision I
[.) coii~J of Konln llllf .,,
<Jo Coi1~J of MddJision.,,
<ii !'>id( IJision•M 5.0h I

D

]Q= Internal h .•.
~.. -~

[

i.J»c1

J

Pt<1~JHme

D Zeh:l<1
Saue

Saue File Rs:

I·.

Cancel
File Format:
PiHel Depth:
Compression:

I

RIFF

I

Compressed

:=====--.
I 8-Bit (256 Grays I I

!1~)1(~ Onlerin~r~

Figure 3- 7 The Save As dialog box.
MacVision supports most graphic file formats. RIFF is
the default file format. You can select the RIFF,
TIFF/Grayscale, TIFF/Bitonal, EPSF, PICT/Version-I, PICI
Version-2 or MacPaint file formats for use with other
applications. If you're not sure which file format to select.
see the chart listing many popular applications in

Appendix E: File Formats.
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You can select the pixel depth for an image when you
save it. You also had an opportunity to set the pixel depth
when you chose New from the File menu.

Compression is available with the RIFF file format.
Compression decreases the size of the image file until you
choose to expand it with any application that supports
these formats. This feature is handy for storing images or
copying them since you use less storage space.
The byte ordering option always defaults to byte
ordering for the Macintosh. If you need to transfer an
image for use on an IBM PC or compatible or PS/2
_computer, select PC.

Printing an Image
Specifying the Page Setup
1.

Choose Page Setup from the File menu.
The Page Setup dialog box appears with the usual
printing options such as paper size and orientation.
=La=s=e=rw=r~it=e=rP=a~g6e=s=et~u=p======~e===========s-=2~H
Paper: @ US Letter
O us Legal
Reduce or
Enlarge:

O R4 Letter O Tabloid
O 85 Letter

llliJill%

Orientation

II~

I

DK
•
•
[ [ancel ]

Printer Effects:
C1!:I Font Substitution?
C1!:I TeHt Smoothing?
C!!:l 6raphics Smoothing?
C1!:I Faster Bltm11p Printing?

Figure 3-8 The Page Setup dialog box for the LaserWriter.
2.

Select the page setup options you want.

3.

Click OK.
For more information about Page Setup, see your
Macintosh system software manual.
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Print
1.

Choose Print from the File menu.
The Print dialog box appears with custom options for
printing MacVision images.
Several Print Options are available. Show Header and
Show Statistics are turned on as the default choice. You
can also select Size to Page, Draw Frame, Trim Corners <H
Invert Image.
,.-- Print Options
~

~

Show He11der
Show St11tistics

D
D

Size to P11ge
Dr11w Fr11me

D
D

Trim rorners
lnuert lm11ge

r - Postscript® Halftones

ll'oWI

D

0

screen Rngle

~ [ells per inch

0

lm11ge Rot11tion

Screen Style:

I Dot

(001

I
[ r11ncel )

Figure 3-9 The custom Mac Vision Print dialog box.
PostScript Halftone Options for PostScript Printers
If you are using a Postscript printer, you can also select
various PostScript Halftone options. The Screen Angle
defaults to 45°, a black & white printing choice that resulh
in optimum output.
You can select the Cells per Inch, an Image Rotation in
degrees and one of several Screen Styles (or dot shapes)
for the screening process. You can also select a halftone
pattern for these dots from the Style Halftone submenu.
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Non-PostScript Printers
MacVision prints the image as a bitmap. Though your
printer doesn't support the Postscript Halftone options,
you can customize the pattern of dots in this bitmap by
selecting a halftone pattern from the Style Halftone
submenu.
2.

Select the MacVision print options you want for printing.

3.

Click OK.
The standard Macintosh Print dialog box appears.
L11serlllriter "ElB L11serlllriter"
Copies:\•\
Couer P11ge:

® No

0 From:

O First

O Lest Pege
O M11nu11I Feed
O Rinck & lllhite

P11ge

® Color/6r11ysc11le

U

OK

JI

LJ To: LJ [Cnncel J

P11ges: ® Rll

P11per Source:® P11per C11ssette
Print:

6.o

~

Figure 3-10 Tbe LaserWriter standard Print dialog box.
4.

Select the Macintosh print options you want for printing.

5.

Click OK.
For more information about MacVision print options, see
the File Print topic in the Chapter 4, Reference. For more
information about the standard Macintosh print options,
see your Macintosh system software manual. For more
information about halftones, see Appendix D, About

Halftones, Grayscale and Bitmaps.

Working With MacVision
For more information about the image enhancement features
in MacVision such as posterizing or using the B & C or
Transfer tools, see Chapter 4, Reference.
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Quitting MacVision
.A.

Choose Quit from the File menu.
If you have made changes to an image file since it was
last saved, MacVision displays a dialog box that lets you
decide whether or not to save these changes.
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Chapter 4

Reference
This chapter contains alphabetical topics for MacVision
menus, commands in those menus, dialog boxes and cursors.

The Apple Menu
About MilcUision® •.•
Help...
:Mi?
SuitCilSe 11
Alilrm Clock
Cillculiltor
Chooser
Control Pilnel
Find File
Key Cilps
Picture Book'"
Scrilpbook

!iJ Finder
..tll MncUision'M

The Apple menu contains two
MacVision commands: About
MacVision and Help.
Desk accessories that you have
installed using the Font DA/Mover are
available while you use MacVision.
If you use MacVision with MultiFinder,
the bottom part of this menu contains
a list of open applications and an
About MultiFinder command.

About MultiFinder ••.

About Mac Vision® ...
Choose About MacVision for the MacVision version number.

Help ... (Command-?)
Choose Help to view helpful information about MacVision.
Reference
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Crosshair

*'}

The Crosshair cursor lets you select areas of an image to cop)
or crop. Do this by dragging diagonally to enclose the area ol
interest with an outline of a box. To cancel the selection, click
anywhere inside the image window. Outside an image
window the cursor changes to a pointer. When you move tlw
cursor into an image window, it becomes a Crosshair cursor.

Edit Menu
The Edit menu contains several
standard Edit commands including
Undo, Cut, Copy, Paste, Clear and
Select All.

IJntlo
l:ut
Copy
Pn~de

I: h>nr
Select Rll

3€K
3€R

Crop To Selection

3€-

Copy Rs ...

It also offers two MacVision
commands: Copy As and Crop To
Selection.

Undo (Command-Z)
Choose Undo to reverse the last undoable action you've
taken. To perform an undo, MacVision needs enough
available memory to store a "before" and "after" copy of an
image for the last change made.
For example, to undo an image crop, MacVision must have
enough memory to store copies of the image before and after
you crop.

Cut (Command-X)
This dimmed command is available for use with desk
accessories that might be used in conjunction with MacVision.
It has no direct affect on MacVision images.
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Copy (Command-C)
Select part of an image to be copied or choose Select All from
the Edit menu. Then choose Copy to place a copy of a
MacVision image on the Clipboard in the PICT format. From
the Clipboard, you can copy or cut and paste the image into
other Macintosh applications. If your Macintosh is using Color
QuickDraw, copying passes grayscale information with the
image.

Paste (Command-V)
This dimmed command is available for use with desk
accessories that might be used in conjunction with MacVision.
It has no direct affect on MacVision images.

Clear (Command-B)
This dimmed command is available for use with desk
accessories that might be used in conjunction with MacVision.
It has no direct affect on MacVision images.

Copy As ... (Command-K)
Select part of an image to be copied or choose Select All from
the Edit menu. Then choose Copy As to select the options
that you want to use for copying an image to the Clipboard.
Select Clipboard-Copy Options.

I
I
Hui tto1w Sl ~Jle; I

Resource Type:
Rendition:

[ Cancel J

PICT/Uersion-2
Grayscale
BaB Mo tria

(

OK

I

I
I
D

Figure 4-1 1be Copy As dialog box.
-------------------------------
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On the Copy As dialog box, you can specify a resource type
of PICTl (the original black and white PICT format), or PICT2
(the color and grayscale PICT format). You can also set the
image rendition to either Grayscale or Halftone.
And if you select Halftone, you can also select a Halftone Styk
such as 8 by 8 Matrix, Tapestry, Line Screen, and so on.

Select All (Command-A)
Choose Select All to select the entire MacVision image.

Crop To Selection (Command--)
Choose the Crop To Selection command to keep only the
currently selected part of an image. Cropping lets you view
only the part of an image youwant to work with.

File Menu
New ...
Open ...

S€N
11€0

Close
Saue
Saue Rs ...

11€S

Page Setup ...
Print .•.
S€P
Print Selection ...
Quit

11€Q

The File menu contains several
standard Macintosh commands that you
may already know how to use: New,
Open, Close, Save, Save As, Page
Setup, Print and Quit. These
commands often include special
MacVision options.
For example, the Page Setup command
displays special MacVision options at
the bottom of the standard dialog box
that let you select a file format and pixel
depth. The Print Selection command
lets you print only the selected area of
an image.

-~
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New (Command-N)
Note: Before you choose New to scan an image, you should
adjust the contrast and brightness controls on top of the
MacVision digitizer. Do this while using the Video Pre•Views
dialog box options to help you. For example, you can
examine a bar graph showing the gray values found in a
column at the center of the image. You can also preview the
image itself and use the Focus options to help you focus your
video camera.
Choose New when you are ready to scan a new image. Before
scanning starts, the Select Digitizing Options dialog box
appears to let you select a capture mode and pixel depth for
the image you are about to scan.
Select Digitizing Options.
Capture Mode:I Norm11I
~:;:::::::~~~
PIHel Oepth:i 8-Blt (256 Gr11ysl

I

[ C11ncel )

l

OK

I

Figure 4-2 Tbe Select Digitizing Options dialog box.

Capture Mode

The Capture Mode pop-up menu lets you select the video
capture method you want to use. The default is Normal. You
can also choose Enhanced, Interpolated or Field.
A field is a collection of horizontal scan lines making up half a
video frame. The even field contains even numbered scan
lines and the odd field contains odd numbered scan lines.
Each of the Capture Mode options determine how MacVision
manipulates the image (a video frame) that it receives from
your video output device

Reference
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.A.

The Enhanced option offers the highest quality because it
samples two consecutive frames of a video image. With the
extra video frame, MacVision can filter out any undesirable
information that may occur on every other frame. Scanning
with Enhanced takes twice as long, but if you are using a
color video output device, Enhanced can often eliminate
unwanted patterns that would otherwise mar an image .

.A.

With Normal, the default option, MacVision digitizes two
fields and interlaces them to build an image. If you are
using a black and white video input device, this is
probably the best Capture method to select.

.A.

With the Interpolated option selected, MacVision
examines one field and averages the values to create the
other field. For example, if the odd field is examined, lines
1 and 3 are averaged to create a value for line 2, lines 3
and 5 are averaged to create a value for line 4, and so on.
This option is a good choice if you are using lower-quality
video output devices .

.A.

If you select the Field capture option, MacVision digitizes
the image using only one field. Since this method saves
memory and storage space, it is a good choice if you have
limited memory or storage space.

For more information about how MacVision scans video
images, see Appendix A, How Mac Vision Works.

Pixel Depth
MacVision will always digitize an image using an 8-bit pixel
depth (256 grays). The Pixel Depth pop-up menu lets you tell
MacVision to interpret, display and save that video image
using 256, 64 or 16 gray levels. 256 gray levels is the default
choice and the one that results in the highest possible image
quality.
With 256 shades of gray, MacVision interprets a digitized
image using an 8-bit pixel depth. For 64 shades of gray,
MacVision interprets using a 6-bit pixel depth. And for 16
4-6
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shades of gray, MacVision interprets using a 4-bit pixel depth.
The lower the pixel depth, the lower the memory and storage
space requirements.
Note: If you choose 64 or 16 gray levels, you would need to

rescan the image if you decided later that you need a higher
resolution of 256 or 64 gray levels respectively.
After you select the Capture Mode and Pixel Depth options
and click OK, MacVision starts digitizing the image. While
MacVision scans a video image and assembles it in memory, a
message displays with a progress indicator to show you how
the scan is progressing.
When the scan is done, the resulting image displays in a new
image window. MacVision sizes the window to take
advantage of your Macintosh computer's screen size. To see
the entire image quickly, choose the Fit To Window
command.

Open (Command-0)
Choose Open to open an existing image. MacVision can open
RIFF and TIFF (grayscale) files, so you can display files in both
these formats in the Open dialog box.

la Koala I
L

=Internal ha ...

Arc hwe Mac U1s1on

CJ Final Rrt
CJ MacUision

~.Ob~

New
Ill'lll(~

Open
Cancel
Select File Type, Creator & Name.
File Type:

I

RIFF & TIFF

I

File Creator:,_!_R_ll_ __,

Figure 4-3 Tbe Open dialog box.
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At the bottom of the Open dialog box are two pop-up
you can use to select a file type or file creator.

menu.~

File Type
Select a file type to display both RIFF and TIFF files, only
RIFF, only TIFF or All files. This option lets you selectively
browse through stored files. MacVision opens RIFF or TIFF
files exclusively, so even though you can view all files, you
can only open RIFF or TIFF files.
File Creator
You can select to view all files or only MacVision files in the
Open dialog box.
Note: If you save a MacVision image in the PICT, PICT2, EPSF
or MacPaint format, you cannot reopen them using MacVision.
Choose the View command to select an image file to bring to
the top of the desktop. Image files are large (200 to 300
kilobytes). If your Macintosh does not have enough memory
to open another image, a message displays to let you know.

Close
Choose the Close command to close the active, or topmost,
image window when you are finished. If you have not saved
the changes you've made to an image, MacVision displays a
dialog box asking if you want to save those changes before
closing the window.
You can also close a file by clicking the close box in the upper
left corner of the window.

Save (Command-S)
Choose Save to store the latest changes you have made to an
image and continue working with it. If the image has never
been saved, a dialog box displays so you can name the file
and decide what folder and/or disk to store it in. This dialog
box is the Save As dialog illustrated in the File Save As topic.
4-8
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If you have not made changes since you last saved, the Save
command is dimmed. When you save an image, it remains in
the active window. The file remains untitled and unsaved as a
MacVision file until you save it in the RIFF format.

For information about selecting a file format and other output
options before saving, see the File Save As topic.
With the RIFF compressed format, you can select how many
bits per pixel to use. You can also set the bits per pixel when
scanning an image with the New command. This option
determines whether you want 256, 64 or 16 gray levels in an
image. Likewise, it affects the size of an image file you save in
the RIFF compressed format. See the File New topic.

Save As •••
Choose Save As to save a new file, to save a copy of an
existing file with a different name or to save a file to a
different folder or disk. You can also specify file output
options that indicate the file format, pixel depth, state of
compression and byte ordering for an image you will save.

Jesi Rrchiue MacUision I
Li Cop~J or Knolo Iliff ,,,
0 Cop~) of '1iH IJision ,,.
O '1<1< 1J1sion'" 5-lll! 1

]Q= Internal h •.•
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]

D P!<1u1 lrn(~
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Saue File Rs:

I·.

Saue
Cancel

I RIFF
I:===:::::::::=::::",-,
8-Bit (256 Grays) I
Compression: I Compressed
I
File Format:

PiHel Depth:

!l~J1e Oni(Jdn~r~

Figure 4-4 The Save As dialog box.
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File Format
You can save an image file in these file formats: RIFF,
TIFF/Grayscale, TIFF/Bitonal, EPSF, PICT/Version-1,
PICT/Version-2 and MacPaint. The RIFF file format is the
default choice and native format for MacVision.

Pixel Depth
You can select how many bits per pixel to use for an image
when you save using the RIFF compressed file format. This
option specifies whether you want 256, 64 or 16 gray levels in
an image. It also affects the size of an image file you save. For
more information, see the File New topic.

Compression
If you choose the RIFF file format, you can also select whetlw1
or not to compress the image. Compression packs information
about an image more tightly in the file to save storage space
on disk.

Byte Ordering
To transfer a MacVision image file to an IBM PC or PS/2
computer or their compatible computers, change the byte
ordering before you save the file. When you transfer the file
using a send/receive utility or over a network, it will be in thl'
correct format for either of those computers.

After you save a f"tle with PC byte ordering, MacVision
can no longer open it.
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Page Setup .•.
Choose Page Setup to select options from the standard
Macintosh Page Setup dialog box. This dialog box lets you
select the paper size, an enlargement or reduction percentage,
the page orientation, printer effects and other options. See
your Macintosh system software manual for more information
about these options.

Print ... (Command-P)
Choose Print to print the image in the active window. A
MacVision Print dialog box displays to let you select printer
options. It also lets you set parameters for Postscript
halftones.
,--- Print Opt i ans

181 Show Header
181 Show Statistics

D Size to Page
D Draw Frame

D Trim Corners
D lnuert Image

,--- Postscript® Halftones

l••I •Screen Angle

Ll •Image Rotation

~ Cells per inch
Screen Style:

I

I Dot
DK

I
J

[Cancel J

Figure 4-5 Tbe Mac Vision Print dialog box.

Print Options
The default choices are to show a header and statistics for an
image. You can also size an image to use the available page
size, draw a frame around an image, trim the corners of an
image to give it a rounded appearance or invert an image.

PostScript Halftone Options
You can select the screen angle, the number of cells per inch,
the image rotation and the screen style.
Reference
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The standard halftone screen angle used by lithographers for
black and white images is 45 degrees since it is the least
noticeable. The default number of cells per inch is 53. You
can select dot, line, square, oval, square dot, lined dot,
triangle, bubble or hourglass shaped dots from the Screen
Style pop-up menu.

Note: Not all of the possible combinations of cells per inch
and screen angles are supported by all Postscript printers. If
you specify a combination that isn't available for your printer,
it uses the closest available combination. See your printer
manual for more information.
For more information on halftones, see Appendix D, About
Halftones, Grayscale and Bitmaps.

The Standard Macintosh Print Dialog Box
After you specify the custom print options for MacVision and
click OK, the standard Macintosh Print dialog box displays.

LaserWriter "EZB LaserWriter"

Copies:l•I
Co11er Page:

@No

0

0

O Last Page
O Manual Feed
O Black & White

first Page

Paper Source:@ Paper Cassette
Print:

6.0

@ Color/llrayscale

from:

n

OK

B

LJ To: LJ (Cancel ]

Pages: @ Rll

~

Figure 4-6 The standard Macintosh Print dialog box.
The options in this dialog box let you select the number of
copies to print, a page range and so on. See your Macintosh
system software manual for more information about these
options.

Print Selection ...
Choose the Print Selection command to print the currently
selected area of a MacVision image.
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When you choose the Print Selection command, a
MacVision Print dialog box appears that lets you select custom
options for MacVision images (see Figure 4-5). After you
select the special print options for MacVision images and click
OK, the standard Macintosh Print dialog box appears to let
you select the usual print options.
If you have not selected part of an image, the Print Selection
command is dimmed on the menu.

Quit (Command-Q)
The Quit command gives you the choice to save each file you
have changed. Then it closes all MacVision windows and
returns you to the Finder.

Grabber

~

The Grabber cursor combines the functions of the horizontal
and vertical scroll bars. You can use the Grabber for more
direct movement of an image inside a window.
Select the Grabber by pressing the Option key while the
cursor is inside an image window. If you press and hold down
the mouse button, you can release the Option key and use the
mouse to scroll an image around in the window.

Reference
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Graymap Menu
The Graymap menu contains
several commands that let you
work with the B & C (Brightness
and Contrast) and Transfer
graymaps for an image.

·•

Show B & c Tool
[2J Default B & C
Show Transfer Tool

[2J Default Transfer
IS] Negate Transfer
Show Posterization Tool
[2J Default Posterization
Default Settings
Rpply Settings
Store Settings
Fetch Settings

You can show and hide the B &
C, Transfer or Posterization tools.
You can reapply default B & C,
Transfer, or both graymap
settings. You can reverse the
Transfer graymap. And you can
store, fetch, and apply graymap
settings.

Show/Hide B & C Tool
Choose Show 8 & C Tool to adjust contrast and brightness.
When you do this, MacVision changes this command to Hide
8 & C Tool and the B & C Tool dialog box appears.
% Brightness::··

so·:

% Contrast: ,.... s.Q':

1~11~10
Figure 4- 7 The B & C Tool dialog box.
You can change the percentage of brightness or contrast by
dragging the sliders left or right.
When you finish working with the B & C Tool, click the close
box in the upper left corner or choose Hide 8 & C Tool to
close the dialog box.
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Original Brightness

Increased Brightness

Decreased Brightness

Figure 4-8 Changing an image's brightness.
For more information about the graymap shown in these
illustrations, see the Show/Hide Transfer Tool topic.

Default B & C
Choose the Default B & C command to clear any changes
you've made to the Brightness & Contrast graymap.

Show/Hide Transfer Tool
Choose the Show Transfer Tool command to work with the
Graymap Editor. Choose Hide Transfer Tool or click the
dialog box's close box to hide the Transfer Graymap Tool
when you finish.
The Transfer Graymap Tool lets you assign, or map, gray
values that will display on the screen and be printed in place
of the actual gray values in an image. Gray values in the
original image remain the same so you can tiy out different
effects and return to the original image whenever you like.
--

----
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Displayed and Printed Image

Fip,ure 4-9 Graymaps act like filters between the orip,inal and
the output imap,e.
You specify gray values for the Brightness and Contrast (B &
C) graymap using the B & C Tool. The changes you make
there affect the B & C graymap (see Figures 4-8 and 4-9).
You can remap individual gray values on the Transfer
graymap using the Transfer Tool (see Figures 4-9 and 4-10).

DrawTool

t1

MacVision starts with the Draw tool selected. It is the hest
choice for making "freehand " changes to the graymap.

PlotTool

I

Click the Plot tool if you want to make very precise graymap
changes - one gray level at a time. Use this tool in
conjunction with the Input Gray and Output Gray indicators at
the top of the dialog hox .
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;;ammm;;;mmm;;mmmm;;;m;;;mmmm;u;m:;;:;m;;1m;m;;;1;;1m1;;m;•mmmmm;mmmmm;;

lllJ 1nput Gray: L:::::::J Output Gray L::::::::J IZJISI

Input Gray•

Figure 4-10 1be Transfer Graymap Tool.
The Transfer Graymap dialog box displays a graph showing
the relationship between the original image's gray values
(Input) and the currently displayed gray values that go to your
screen or printer (Output). Input gray values are on the
horizontal axis and output gray values are on the vertical axis.
;;a;;;;mmm;mmm;;m;;;m;;m;;;m;;mmm;mm;;m;mmm;;m;;;m;m;;;m;;mmmmmmm;mm;;;

lllJ 1nput Gray:!::::

:::J Output Gray L::::::::J

IZJISI

Input Gray •

Figure 4-11 Gray Value Input and Output.
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When the graph displays a diagonal line from the lower left to
the upper right corner as it does initially, there is a 1:1 (one to
one) relationship between input and output. If the line is
reversed (from the bottom right to the top left), the graph
indicates that the output is opposite to the input. This
produces an image that looks like a photographic negative.
The pixel depth specified in the Video Input Options dialog
box also specifies the number of gray values available for an
image in the Transfer Graymap dialog box.
Pixel Depth Options
8 (256 Gray Levels)
6 (64 Gray Levels)
4 (16 Gray Levels)

Gray Values in Graymap
256
64
16

For a 256-gray level image, each gray value is assigned a
number between zero (white) and 255 (black). If you move
the cursor inside the graph, the numbers in the input and
output boxes at the top of the Graymap Editor change. These
input and output numbers show the output gray value that
would be used in place of the input gray value if you clicked
at the current cursor location.

The Transfer Graymap
If you draw new lines in the graph, you are changing the
Transfer graymap. If you adjust the Posterization or click the
graymap icons, you are also changing the Transfer graymap.
The Transfer graymap is represented on the graph by a solid
line.

The Brightness & Contrast Graymap
If you drag the sliders to increase or decrease the Brightness
or Contrast controls in the B & C Tool dialog box, you are
changing the B & C graymap. The B & C graymap is
represented on the graph by a dotted line.
Note: As you make changes to either the Transfer or B & C

graymap, MacVision changes the image on screen. This way
you can see the results of any changes as you make them.
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Default Transfer
Choose the Default Transfer command when you want to
clear any changes you 've made to the Transfer graymap.

Negate Transfer
Choose the Negate Transfer command to reverse the
Transfer graymap. This is a fast way to create a photographic
negative effect.

Figure 4-12 Negating the Transfer map.

Show/Hide Posterization Tool
Choose the Show Posterization Tool command when you
want to select the number of gray levels for an image. Using
fewer gray levels creates a poster-like effect.
Posterizetion :L::::::~:! llJ

Figure 4-13 7be Posterization Tool dialog box.
When you finish posterizing an image, choose the Hide
Posterization Tool command or click the close box to close
the dialog box.
You can drag the slider left or right or click the Up or Down
Arrow buttons to change the poster levels in an image. To
create a posterized effect try using six or eight levels of gray.
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Figure 4-14 Posterizing an image at six levels ofgray.

Default Posterization
Choose Default Posterization when you want to quickly
return an image to the original number of gray levels: 256, 64,
or 16 depending upon the pixel depth you set initially.

Default Settings
Choose Default Settings to revert to the default graymap
settings: 50% and 50% for the B & C graymap; 1: 1 for the
Transform graymap; and 256, 64 or 16 gray levels for
posterization depending on the pixel depth you set initially.

Apply Settings
Choose Apply Settings to apply the graymap settings to the
image. This also resets the graymap settings to default values.

Store Settings
Choose Store Settings to store the current graymap settings
so you can fetch them later with the Fetch Settings command.
The last stored settings are saved when you quit MacVision.
They are restored when you launch the application. This is a
good way to create the same effect easily for several images.

Fetch Settings
Choose Fetch Settings to recall the last graymap settings you
stored with Store Settings.
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Experimenting with Graymaps
You should experiment with the Graymap Tools since the
effects are cumulative: you can produce some fascinating
effects.
For example, you might try solarizing an image. A solarization
effect is one that can happen in a darkroom when light hits a
partially developed print. You can simulate this effect by
reversing some gray levels on the Transfer graymap.
ml ··~··'····

~·····~··•
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Figure 4-15 Solarize an image by darkening light areas.
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MacVision Image Window
The MacVision image window, illustrated in Figure 4-16, is a
standard Macintosh document window. The window also
contains a menu bar and scroll bars.
After you scan an image, it appears in an image window. As
with other Macintosh document windows, you can change the:
size and position of a MacVision image window by dragging
the bottom edge or by clicking the Zoom box. You can use
the scroll bars to view parts of an image that extend beyond
the edges of an image window.

Figure 4-16 The Mac Vision Image Window.
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Pointer

~

The Arrow Pointer is a standard Macintosh cursor that you use
to select something on the desktop. For instance, you use the
Arrow Pointer to choose commands from menus, click
buttons and so on. In MacVision, the Pointer is available
outside a MacVision image window, in dialog boxes and
within the horizontal and vertical scroll bars.

Style Menu
Grayscale
Halftone

~

Smoothen
Shaue
Soften
Sharpen
Shadow
Shape

The Style menu contains the Grayscale
command and Halftone submenu that let
you choose a grayscale or halftone image
type. MacVision defaults to the best image
type available for the Macintosh you are
using.

This menu also contains the Hue Setup,
Smoothen, Shave, Soften, Sharpen,
Shadow and Shape commands that let
you use special effects to enhance an
image. The best way to learn about these special effects
commands is to experiment with them. The Smoothen,
Soften, Sharpen, Shave, Shadow and Shape commands are
cumulative. Using them repeatedly and mixing the commands
can produce a wide variety of effects.

Grayscale
Grayscale is the default image type when you use MacVision

on a Macintosh with grayscale capabilities. When using
grayscale images with a Postscript printer, you can select
Postscript Halftone options in the MacVision Print dialog box.
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Halftone Submenu
8H8 MatriH
4H4 MatriH
Tapestry
Feather
Painted
Threshold
Outline
Contour
Zebra
High 6rain
line Screen

MacVision offers 11 halftone
patterns for simulating halftones
on low-resolution output
devices such as screens or
printers.

Halftone Patterns

The Halftone submenu lets you
select a halftone pattern for
rendering the original grayscale image. The 8 x 8 ordered
matrix is the default halftone pattern.
Although the pattern names provide some indication of the
effect they produce, the best way to understand their effects is
to try them out. You can apply a different halftone pattern to
different parts of an image by selecting the area and choosing
a Halftone pattern.
For more information about halftones, see Appendix D, About
Halftones, Grayscale and Bitmaps.

Hue Setup ...
Choose Hue (if you have a color monitor and Monitors in the
Control Panel is set to Color) to select a color that should
replace white in an image. When you choose Hue Setup, the
standard Macintosh Color Picker dialog box displays as
illustrated in Figure 4-i7.
If you aren't familiar with the HSB or RG B color models, you
can easily select a color on the color wheel. You might note
the three values for either color model so that later you can
match a hue exactly.
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The Select Image Hue box
The Select Image Hue box at the top left of the dialog box
displays the current color in the bottom half of the box. It
displays the new color you picked in the top half of this box.

Select Image Hue:

1.S

~
Hue
Saturation
Brightness
Red
Green
Blue

00
00
lmlll 00
57H4 00
40960 00
8192
00
7281
56174

Figure 4-17 1be standard Macintosh Color Picker dialog box
lets you select a color using the HSB color model, the RGB
color model or the color wheel.

Hue, Saturation and Brightness
Hue , Saturation and Brightness is called the HSB color model.
If you use HSB regularly, you can click the Up or Down
Arrow buttons or type the value for hue, saturation and
brightness.

Red, Green and Blue
Red, Green and Blue is called the RGB color model. If you use
this model, you can either click the Up or Down Arrow
buttons to select a color or type the red, green and blue values
directly in the text boxes.
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The Color Wheel
This color wheel lets you select a given hue and saturation
simultaneously. The center of the wheel displays zero
saturation with no hue mixed in. Colors at the outer edge of
the wheel have maximum saturation with no gray mixed in they are pure hues.
Click the color in the color wheel that you want to select and
the new color displays in the top half of the Select Image Hue
box.

Experimenting with Hues
You can create a sepia image, for instance, by selecting a
brown color with a hint of violet. Then choose Negate
Transfer from the Graymap menu to reverse the image. The
brown now replaces black instead of white in the image, like
the sepia drawings that were created in the 18th century.

Smoothen
Choose Smoothen to blend the edges in the selected portion
of an image. If you haven't selected part of an image,
MacVision smooths the entire image. Smoothen is useful for
creating an "out of focus" effect or for reducing high contrast
selectively.

Shave
Choose Shave to downplay small projections along the edges
in the selected portion of an image. If you haven't selected
part of an image, MacVision shaves the entire image. Shave is
useful for toning down jagged edges.
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Soften
Choose Soften to decrease contrast in the selected part of an
image. If you haven't selected part of an image, MacVision
softens the entire image. Soften is useful for reducing moire'
patterns. If you soften an image to reduce moire' patterns, try
sharpening afterwards to bring out the edges.

Sharpen
Choose Sharpen to increase the contrast of edges in the
selected portion of an image. If you haven't selected part of an
image, MacVision sharpens the entire image. Sharpen is
useful for pulling out the details in low-contrast images.

Shadow
Choose Shadow to add shadows or darken the edges in the
selected portion of an image. If you haven't selected part of an
image, MacVision shadows edges in the entire image.
Shadow is useful for adding or enhancing shadows in a
bright image.

Shape
Choose Shape to shape or highlight the edges in the selected
portion of an image. If you haven't selected part of an image,
MacVision shapes edges in the entire image.

Video Menu
Enable Watchdog
Input Options...
Pre•Uiews...

Kl
Kl

Swap Fields

K=

Reference

The Video menu contains the
Enable/Disable Watchdog, Input
Options, Pre•Views and Swap
Fields commands.
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Enable/Disable Watchdog
MacVision starts with the Watchdog monitoring feature turned
off. When you turn it on by choosing Enable Watchdog, the
Disable Watchdog command displays at the top of the Video
menu. Choose Disable Watchdog to turn off this feature.
The watchdog monitoring feature lets you know instantly if
the connection is broken between MacVision and your video
input device. For instance, your MacVision cables might
become loose or disconnected, the video input device might
be turned off, and so on. This feature lets you know that
something is amiss by repeating the System sound and
flashing the Video menu title.

Input Options ...
Choose the Input Options command the first time you start
MacVision. The Input Options dialog box contains options
you'll probably set once or only occasionally as illustrated in
Figure 4-18.
Select Input Options.
Serial Port:

I

[%]Modem'

Uideo Standard:~
[ [ancel

l

n

OK .

I

Figure 4-18 7be Input Options dialog box.
Important: Be sure you define your video environment by
setting these options before you scan an image.

Serial Port
The Serial Port pop-up menu lets you specify whether you
connected the MacVision digitizer to the Modem or Printer
port on the Macintosh. The Modem port is the default choice.
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Video Standard
The Video Standard pop-up menu lets you specify whether
your video input device uses the NTSC or PAL standard.
NTSC is the color system developed by the National
Television Systems Committee. It is the default choice and is
used throughout the United States, Japan and in most of North
and South America. NTSC uses a total of 525 scan lines per
frame and displays 30 frames per second.
PAL is the Phase Alternation by Line color standard used in
Europe and other areas. PAL uses a total of 625 scan lines per
frame, displays 25 frames per second, and is an option
available only with specific MacVision PAL hardware.

Pre•Views ...
. Choose the Pre•Views command to prepare for scanning an
image. When you choose this command, the Pre•Views
dialog box appears as illustrated in Figure 4-19.

II

Adjust B & C

~

Quick View

@]
Focus Zoom 2 :1

~

Focus Zoom 4 :1

OK

Figure 4-19 Tbe Pre• Views dialog box with Adjust B & C.
Adjust B & C is the default option. It displays a bar chart that
can help you optimally set the Brightness and Contrast. The
Brightness and Contrast knobs are located on top of the
Reference
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MacVision digitizer. You can also preview an image before
you scan it with the Quick View option and focus using the
Macintosh screen if a viewfinder or small TV monitor isn't
available.
AdjustB & C
The Adjust B & C option produces a real-time bar chart that is
repeatedly updated in the Pre•Views dialog box. MacVision
creates this bar chart by sampling the gray values in a column
down the center of a video image.
Tht> gray values found in this image sample are translated into
the horizontal bar chart illustrated in Figure 4-19. You can use
this information in two ways: to analyze how bright an image
will be and to analyze how much contrast an image will have
before you scan it.
When black lines extend left past the black end of the bar
chart without line tips visible, that part of the image is most
likely too black. MacVision won't be able to pick up any
subtle shades near the black end. You may want to increase
the Brightness by turning the Brightness knob on the
MacVision digitizer clockwise until the black lines fall within
the edges of the bar chart.
Likewise, if the white lines extend beyond the white side of
the bar chart, the image is probably too light. You may want
to turn down the brightness to bring the ends of the white
lines back within the edges of the bar chart.
Note: If the bar chart is totally black, the image will be black.
If it is all white, the image will be white. In either case, turn
the Brightness knob until you begin to see black and white
line tips. MacVision regularly updates the bar chart by taking
new samples. You should begin to see a mix of black and
white lines shortly after you adjust the Brightness knob.
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To analyze the contrast in an image, you should compare the
distance between the ends of the white and black lines. If the
ends of the white lines are very far from the ends of the black
lines, the contrast in the image sample is high. If the ends of
the white and black lines are very close, the contrast is low.
Turn the Contrast knob on top of the MacVision digitizer to
get the contrast you want for an image.

Quick View
You can preview an image before scanning it with the Quick
View option illustrated in Figure 4-20.
Column•

~c

AdJUSt B &

@]
Foc:us Zoom 2 :1

[Q
FOCUS Zoom 4 1

OK

Figure 4-20 Quick View continuously updates an image
preview, painting it from left to right.
MacVision paints a low-resolution image so the preview can
update more quickly. After you click Quick View, the image is
painted from left to right. You can easily move around the
focus box in the center of the Quick View display to pinpoint
an area you'd like to focus on with either the Focus Zoom 2:1
or 4: 1 options.
You can adjust the Contrast and Brightness knobs on the
MacVision digitizer while viewing the Quick View display and
see the changes instantly.
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Focus Zoom 2: 1
The Focus Zoom 2:1 option lets you use the Macintosh screen
to help you focus the image output from the video source.
The image is displayed at a 2 to 1 ratio, or twice the size. This
is especially useful if your video source doesn't have a
viewfinder and a monitor is unavailable.
When you click Focus Zoom 2:1, MacVision displays a focus
box in the middle of the image in the Pre• Views dialog box.

~

Adjust B & C

Column•

la

jg

Quick View

II

Focus Zoom 2 :1

Focus Zoom 4 :1

OK

Figure 4-21 Focus Zoom 2: 1 displays the focus box at twice
the size.
Focus Zoom 4:1
The Focus Zoom 4:1 option works just like the 2: 1 option;
however, it increases the image inside the focus box to four
times the size.
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Column •

~

Adj1Jst B & C

la

8

01Jick Vle-w

@]
Focus Zoom 2 :1

II

Focus Zoom 4 :I

OK

Figure 4-22 Focus Zoom 4: 1 displays the focus box at four
times the size.

Swap Fields (Command-=)
Choose Swap Fields to switch the sequence of the two
interlaced fields that MacVision scans from a video frame .
Swapping fields can correct image distortions resulting from
an incorrect interlace. You can best see this kind of distortion
by examining diagonal lines in an image. Figure 4-24
illustrates what happens to an image when the fields are
incorrectly interlaced.
A field is a group of odd or even lines in a video frame. A
video frame is divided into these two fields to reduce flicker
that would appear on a lV screen by increasing the number
of scenes presented to the eye per second. See Figure 4-23.
To determine the correct field sequence, MacVision analyzes
two pairs of scan lines in the middle of the image. If it detects
that the fields are interchanged, it swaps them for you. If
MacVision makes the less desirable choice, you can easily
swap the fields using this command.

j.{eference
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Even and odd fields interlaced in a video frame.
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Enlarged view of individual pixels in fields, or scan lines, 1
through 6.
Figure 4-23 7be correctly interlaced fields on the left side of
the figure form a pyramid. 7be incorrectly interlaced fields at
the right side of the figure produce "jaggies" down the
diagonal lines.

View Menu
.;copy of Koahl RIFF #1
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The View menu contains the Fit
To Window/Show Actual
Size command that let you
switch between a reduced and
a normal size view of an image.
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At the bottom of this menu, MacVision lists all currently open
documents by name. You can open as many images as your
memory will allow.

Fit To Window/Show Actual Size
Choose the Fit To Window command to resize an image to
fit within the borders of the current window. If you resize the
window while Fit To Window is in effect, the image is
resized so it continues to fit in the window. The resized image
retains the aspect ratio of the original so you won't see any
distortion. Since the entire image is visible when fit to a
window, the scroll bars and Grabber are inactive.
Note: If you are using a black and white monitor, an image
that you fit in the window appears darker since the pixels are
. compressed. The image contrast is not affected during
printing since shades of gray rather than a bitmap are used.

Choose Show Actual Size to return an image that is currently
fit to a window to its original size. The Show Actual Size
command restores the image to its normal size and reactivates
the scroll bars and Grabber.

Image Window Name (Command-0-9)
MacVision displays a list of the open documents in windows
by their filename.
The number of images you can open at a single time depends
upon the amount of available memory on your Macintosh.
To bring an image to the top of the desktop, choose the
corresponding filename from this list.

--------------
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Appendix A

How MacVision
Works
MacVision is a hardware and software system that digitizes
video images generated hy a video camera, still video camera,
VCR or laser disk player. After a video image has heen
digitized, or scanned, MacVision stores it in memory and
displays it in an image window on your Macintosh.
The image displays as a monochrome (black and white)
image with 256 shades of gray or as a bitmap. You may save
the images in a variety of file formats and print the images on
Macintosh compatible printers.

Analog and Digital Images
Video images, like photographs, are "analog" images. Analog
images have a continuously changing range of brightness
values going from solid black to solid white with an almost
infinite number of gray levels in between.
Since your Macintosh uses digital rather than analog images,
the analog video output must he converted to digital
information. To make a high-quality digital image from the
analog video image, MacVision takes hundreds of thousands
of digital samples of the video image output. Each sample
contains a digital code describing the brightness of the video
image at that sample point.
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The MacVision hardware is a peripheral device called a video
digitizer that is used to generate the image samples. The
digitizer takes a video signal, digitizes it and then transfers the
information to the Macintosh through a cable connected to the
Macintosh modem or printer serial port.
The MacVision software controls the sampling process,
assembles the image in the computer's memory and displays it
on the Macintosh screen.
The digitized image created by MacVision is a discrete
grayscale approximation of the original analog video image.
In digitizing an image, MacVision uses 256 discrete gray levels
to approximate the continuous range of gray values in the
original analog video frame. When viewed on a good monitor
or printed on a high-resolution printer, digital images with 256
shades of gray have a visual quality approaching that of a
photograph. Humans can at most distinguish 256 gray levels.

Understanding TV Video
An NTSC video frame, produced by a TV camera, consists of a
total of 525 horizontal scan lines. Of these, 480 scan lines
contain the image and the remainder are used to frame the
image and pass other information. You've probably seen the
extra 45 scan lines when a TV picture rolls vertically.
The process of dividing a video image into scan lines is
known as raster scanning. It effectively breaks the original
scene viewed by the video input device into 480 strips of
picture information stacked one on top of the other. Each scan
line contains the continuously changing brightness
information and a pulse to synchronize the scanning of the
video input device image with the displayed image.
In creating the raster scan of a scene, the video input device
starts in the upper left corner. After generating 480 scan lines
the camera ends the image scan in the lower right corner
ready to jump back to the upper left corner and start over.
A-2
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A standard NTSC television video frame is actually formed by
interlacing two video fields each with 240 horizontal lines of
brightness information. This constitutes a full frame of
information. One field contains the even numbered scan lines,
the other contains odd numbered scan lines.
By displaying the odd field and then the even field on the TV
screen, you see 60 representations of an image on the TV
screen each second. (30 frames per second x 2 fields = 60
image representations.) This is done to eliminate the screen
image from flickering.
When these two interlaced fields are displayed on a TV screen
the human eye is tricked into seeing a single 480-line image.
For maximum image quality, MacVision takes samples from
both of these fields and arranges them to form a complete
480-line digital image.
The digitizing process is synchronized to individual video
frames by using the horizontal and vertical synchronization
pulses contained in the composite NTSC video signal. The
MacVision software controls how the horizontal scan lines are
sampled and assembled into a digital image in your
Macintosh's memory.
Each sample of the video frame contains 8 bits of information
that represent the gray levels at the point in the image where
the sample was taken. With 8 bits of information per sample,
the scanned image will have 256 gray levels.
The MacVision software distinguishes between the two video
fields and puts the samples in the proper order in memory. In
situations where MacVision cannot determine the field
sequence accurately, MacVision offers a Swap Fields
command so you can easily choose the correct field order.
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Digitizing an Image
Digitizing a horizontal scan line in a video image involves
taking numerous samples of the video voltage level that
represents the changes of brightness across an image.
MacVision takes 640 samples of each of the 480 scan lines and
stores the results in memory as a collection of bits that
describe the video frame.
Each of these individual brightness samples is known as a
pixel or picture element. A pixel or picture element is a tiny
dot. MacVision produces a digital image composed of 640 by
480 pixels. This number of samples results in a digital image
with approximately the same horizontal and vertical
proportions as the original video frame.
The digitizer hardware contains a circuit known as an
analog-to-digital (A to D) converter. The A to D converter
samples the analog video at each point in the 640 by 480
image matrix. For each sample, it assigns an 8-bit character
that describes the brightness level of that sample point or
pixel.
The 8-bit samples taken by the MacVision digitizer provide
256 shades of grayscale information. If you wanted to digitize
black and white (no shades of gray), only one bit of data per
pixel would he necessary. To record 16 levels of brightness
four hits of data are required. And to record 64 levels of
brightness, six bits of data are required.
The Macintosh II series monitors and some Macintosh SE/30
monitors can display images with up to 256 discrete shades of
gray. This means they can take full advantage of the 8 bits of
brightness information produced by the MacVision digitizer.
When you display the digitized image on a Macintosh Plus, SE
or Macintosh Portable it appears as a bitmap which simulates
the shades of gray.
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Producing a Digital Image
To shorten the processing time needed to assemhle image
information, one sample is taken from a horizontal scan line
in consecutive video fields. This reduces the effective time for
each sample to 63.5 microseconds. MacVision can sample,
transmit and assemhle in memory the 310,000 samples in a
640 by 480 pixel image in approximately 20 seconds.
The output from the MacVision digitizer is a serial hit stream
that represents consecutive vertical columns of samples. The
data is sent to the Macintosh serial port at 230 kilobits per
second. The serial bit stream is decoded and assemhled in
memory as eight 640 hy 480 bit planes, each plane
representing one of the eight hits of data needed for 256
shades of gray.
You can store the MacVision image in memory, display,
change, print and save it in one of several file formats. You
can use the digital images created hy MacVision with other
applications such as desktop puhlishing, multimedia
presentations, HyperCard, draw or paint applications.
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Tips on Selecting a
Video Input Device

MacVision hrings together the technologies of photography,
video and computers. In photography the sharpness and
resolution of an image is determined hy the camera, film and
lens quality.
In video the electronic image sensor in the camera is the
equivalent of the photographic film, while the electronic
circuitry that converts the sensor output into a video frame for
viewing or recording is the camera.
The important role of high-quality lenses is the same in hoth
photography and video. For the highest quality digital images
with MacVision you should use a high-quality hroadcast video
camera to capture the image.

Types of Video Cameras
Although you can use almost any home video camera with
MacVision, a high-quality hlack and white industrial video
camera will produce the hest results.
Color video cameras, still video cameras and camcorders can
he used with MacVision, however the image sharpness is
usually less than a comparahly priced industrial hlack and
white camera. Industrial cameras are huilt to deliver good
quality and reliahle performance 24 hours a day, seven days a
week for years.
Appendix B Tips on Selecting a Video Input Device
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The industrial camera should have a good quality fixed or
zoom lens, preferably with a macro setting. The video camera
should he held steady hy a good tripod or copy stand
mounting. For best results, all video cameras require adequate
lighting of the subject.

Inside a Video Camera
A video camera system is composed of two basic parts:
.&.

the camera body holding the image sensor that converts
light coming through the lens into an electronic signal.

.&.

the lens that forms the optical image of the subject on the
sensor.

When selecting a video camera, pay special attention to the
type of image sensor used and the specifications of the lens.
Video cameras have two types of image sensors: tube and
solid state. The tube type is called a videcon and is used in
most low-priced consumer and industrial cameras.
The tube type sensor does not produce as sharp an image as a
solid state sensor. The videcon also has a limited light range
making it less able to produce images in low light and more
likely to he damaged hy exposure to bright light such as the
sun.
The solid state sensor uses a semiconductor chip called a
Charge Coupled Device or CCD. The CCD sensor is more
expensive than the videcon hut has better sensitivity, wider
dynamic range, better resistance to vibration and shock, is
smaller and lighter and produces a crisper image. A CCD also
produces an image with less distortion at the edges and
corners. Video cameras using a CCD image sensor give you
the best results with MacVision.
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Types of Lenses
For many MacVision applications a fixed focus lens will be
adequate. To change what is in the picture, the camera can be
moved closer to the subject or farther away. For a given level
of quality, fixed focus lenses are less expensive than zoom
lenses. A lens with an 12mm focal length is normally used
with small video cameras.
A zoom lens can change focal length either manually or under
electronic control. Using a zoom lens can add considerable
flexibility to your camera. The typical zoom range is a ratio of
six to one, although some lenses zoom from a 2.5mm wide
angle to a 75mm telephoto.
Most home video cameras incorporate zoom lenses. With
industrial cameras, the lens is purchased as a separate item so
it can be selected to meet the specific needs of the system.
Due to the compromises made in designing zoom lenses, a
fixed focus lens generally produces a higher quality image at
any particular focal length. For most uses, however, the
convenience of the zoom lens more than offsets the slight loss
of picture quality.
Whether you choose a fixed or zoom lens, for additional
flexibility get one with a macro feature. With a macro setting
the lens can be made to focus down to just a few inches from
the subject. This macro capability will add great versatility to
your camera system and allow you to do close-ups of small
objects.
Camera system prices generally include a power supply,
cables and cable adapters.
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Video Monitors
One advantage of the consumer or home video cameras is
that they usually incorporate a miniature video monitor as a
viewfinder. This lets you see exactly what the camera is
including in a video frame.
Since industrial cameras do not have integrated monitors, you
can either invest in a small video monitor or use MacVision's
Focus option in the Pre• Views dialog box to instantly observe
what the camera is seeing. Compact video monitors are of
great help when composing and adjusting MacVision images.

Video Recorders
Video recorders and disks are also an excellent source of
images that can be digitized by MacVision. To digitize an
image from a video recorder, be sure you use the freeze frame
feature of the recorder.
Older video recorders achieve freeze frame by rotating a
special playback head over a selected portion of the tape. In
order to have a good freeze frame feature, a video recorder
must have at least four heads.
Newer video recorders achieve still frames by digitizing the
frame, storing it in memory and then repeatedly reading it
from memory and converting it back into an analog video
signal. The technique used to create the still frame can have a
great effect on the quality of the resulting MacVision image.
The digital type of VCR freeze frame generally produces the
best results.
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Still Video Cameras
Still video cameras have been introduced at the retail level
that offer advantages and disadvantages when used with
MacVision.
A major advantage is that you can freeze a moving image that
might otherwise be lost. The disadvantage is that low-end still
video cameras do not offer the best image quality. Some of
these cameras record a single field rather than a full frame, or
two fields of information. This means that MacVision receives
only about half the video image information.
Higher quality still video cameras that operate in the
full-frame mode are available.

Quality Loss Due to Motion
When a sequence of frames of a moving subject are recorded,
each frame is slightly blurred by the motion of the subject or
the camera.
A video frame is I/30th of a second in duration. This is the
equivalent of taking a picture with a still camera at a shutter
speed of I/30th of a second. At this relatively slow shutter
speed, any movement of the subject or the camera can
produce a blur in the picture.
Video cameras should be mounted on a sturdy tripod or copy
stand so that there is no camera movement while the image is
being digitized by MacVision. Copy stands provide a camera
mount, well-balanced lighting and a holder for flat artwork.
Since MacVision takes about 20 seconds to produce an image,
be sure that lighting and other factors remain constant during
the frame digitizing time. Also, your subjects must remain
totally still for the entire digitizing time.
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Appendix C

Tips on Lighting
Proper lighting plays a major role in obtaining good results
with the MacVision Video Digitizer. Proper lighting can make
the subject look more three dimensional and realistic.
MacVision combines photography and computers so it is
essential that you have some understanding of the principles
of photographic lighting.
Some of the basics of photographic lighting are presented
here. For more information, a number of excellent hooks on
lighting are usually available at camera stores and public
libraries.
The general principal of good lighting is to balance the light
and dark areas and provide a good range of grayscale tones.
Too much light makes the subject look washed out; too little
light causes the subject to recede into the background; wide
extremes of light are generally to be avoided.

---~-----
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Lighting Three Dimensional Objects
Proper lighting of three dimensional objects requires at least
two lights: a key light and a fill light.
The key light provides the main lighting of the subject,
clearly separating it from the background. The key light is
placed closest and at an angle to the subject.
The fill light sculpts the subject and provides the grayscale
tones that are important to realistic images. The fill light is
placed slightly further from the subject than the key light.
In some situations a third light, called a high light, is used to
further mold the subject. When making images of people, you
can use a high light to make the hair look radiant and more
distinct from the background.
You can obtain some interesting lighting effects by carefully
using only one light:
.&.

A key light alone can create a moody, brooding image .

.&.

A high light alone creates an ethereal looking image .

.&.

Lighting only the background produces a silhouette.

Three Dimensional Lighting

Figure C-1 1bree Dimensional Lighting.
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Lighting Two Dimensional Art
The best way to capture images of flat art such as drawings,
posters or photographs is to place the art on a flat surface and
mount the camera at a right angle to the art. Three types of
camera setups are well suited to making images of flat art:
&

A photocopy stand that combines a flat surface, camera
mount and light fixtures into a convenient table top unit.
Most photo stores carry copy stands.

&

A small rigid tripod can be used to hold the camera aimed
down at the artwork laying on a table.

&

A tripod standing on the floor with the camera pointed
horizontally at the artwork on a vertical easel.

Keep art flat while photographing. It should be held flat by
weights, tape or, best of all, a sheet of glass.
Light flat art at an angle. Use two lights to ensure even lighting
over the surface of the art.

Two Dimensional Lighting

COPVSTAN:>

TRIPOD ON TABLE

TRIPOD & EASEL

Figure C-2 Two Dimensional Lighting.
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About Halftones,
Grayscale and Bitmaps

Your Macintosh environment is a major factor in determining
how a MacVision image appears on the screen and in print.
For example, an image can display more shades of gray if you
use Color QuickDraw on a Macintosh II than if you use the
original QuickDraw on a Macintosh Plus.
This appendix explains the underlying techniques involved in
reproducing images on Macintosh screens and compatible
printers.

Macintosh Screens and Printers
When reproducing an image on a Macintosh computer, there
are two major concerns: how the image appears on the screen
and how the image is printed.

Macintosh Screen Displays
No matter which Macintosh computer you use, the screen
displays 72 pixels or dots per inch horizontally and vertically.
Each pixel is square and all are the same size. Square pixels
produce higher quality graphics on the screen than other pixel
shapes such as rectangles.
Note: QuickDraw uses 72 dots per inch to calculate screen

information, though the actual screen measurement may vary
slightly.
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On a monochrome screen such as on a Macintosh Plus,
SE or Portable, each pixel is either turned on (bright) or
turned off (dark.) Each pixel represents one bit in a
two-dimensional bit image. If a pixel is white, the bit for that
pixel is set to zero; if the pixel is black, its bit is set to one. A
bit image is a black and white image.
To allow all Macintosh applications to handle graphics
consistently, Apple offers QuickDraw as part of the developer
Toolbox. QuickDraw performs all graphic operations on the
Macintosh screen, provides a standard way for storing bit
images and draws text and graphics on the screen.
On a grayscale screen such as on a Macintosh D or an
external grayscale screen for an SE/30, the brightness
intensity of each pixel can be set independently. By varying
the brightness, shades of gray can be more accurately
depicted. This means that more than one bit of information is
needed to define each pixel.
Apple introduced Color QuickDraw to handle this extra
grayscale information by storing a pixel image rather than a
bit image. A pixel image is a multiple-bit-per- pixel bitmap
that can specify either color or grayscale information.
With Color QuickDraw, you can select how many shades of
gray or color will display on the screen by setting Monitors to
Black & White, 4, 16 or 256 shades of gray or color on the
Control Panel. So, even with a MacVision image that contains
256 gray levels, you will see fewer shades of gray on the
screen if you have reduced the number of grays on the
Control Panel.
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Macintosh-compatible Printers
QuickDraw also prepares an image for printing.
On a non-PostScript printer such as the Apple
ImageWriter, QuickDraw converts information about an
image into a one-bit-deep bitmap. The resolution achieved
depends upon the image and your choices in the Page Setup
and Printer dialog box as illustrated in the chart below.

lmageWriter Print Resolution
Dots Per Inch

Print Quality
Best
Faster
Draft

Tall Adjusted On Tall Adjusted Off
Vx H*

Vx H*

144 x 160

144 x 144

72 x 80

72 x 72

-

-

• Vertical times Horizontal.

On a PostScript printer such as the Apple LaserWriter,
QuickDraw translates image information into the Postscript
page description language or into bitmap information in a
form that Postscript can use. A LaserWriter, for example,
prints at a resolution of 300 dots per inch.
Some laser printers for the Macintosh can produce resolutions
of 400 or 600 dots per inch. If you need typeset quality, laser
imagesetters can produce dramatically higher resolutions of
up to 2,540 dots per inch.
Resolution is reduced when the Faster Bitmap Printing option
in the Page Setup dialog box or the Black & White option in
the Print dialog box are selected. You can choose the highest
resolution by turning off Faster Bitmap Printing and selecting
Color/Grayscale in the Print dialog box.
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What are Halftones?
The halftone techniques developed for lithographers are
simulated to reproduce images on Macintosh screens and
printers.
Halftones were first developed to reproduce continuous-tone
images such as photographs or illustrations in letterpress and
offset printing. Since both printing processes place a uniform
ink density on paper, the shades of gray in a black and white
photograph would be lost leaving only black or white.
Lithographers need to break up the ink density to reproduce
shades of gray. They do this by creating a halftone
photograph from an original continuous-tone photograph.
To create a halftone photograph, a lithographer places a
halftone screen between the original photograph and the film
in a camera. A halftone screen is a glass or film sheet covered
with tiny dots of different sizes. On the resulting halftone
photograph, the original image is divided into dots.
These halftone dots produce an optical illusion. They cause
the human eye to see different gray levels as though the
image had been printed with varying densities of ink.
Each gray level has a corresponding halftone dot size. For
example, if a halftone image has 256 shades of gray, there are
256 dot sizes. Black areas have the largest dot size. Also,
halftone dots are available in different patterns and shapes.
Halftone photographs are used in newspapers, magazines and
fine art - examples are all around. Examine a newspaper
photograph closely and you can probably see the halftone
dots. They are especially visible in lighter gray areas since
those dots are smaller. You might use a magnifying glass to
see these halftone dots more clearly.
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The resolution of a halftone photograph corresponds to the
spacing of the dots. Spacing is defined in lines per inch. For
instance, newspapers use halftone screens with 55 to 85 lines
per inch. Magazines use halftone screens with 120 to 150 lines
per inch. Fine art uses halftone screens of 200 lines per inch.

Printing Halftones on a Macintosh
The IrriageWriter can print up to 144 x 160 dots per inch and
the LaserWriter can print up to 300 dots per inch. So, you
might think it a simple matter to reproduce halftone images at
least as good as those used in magazines with an ImageWriter
or LaserWriter.
However, the halftone dots used on halftone screens vary in
size while the dots printed on an ImageWriter or LaserWriter
are all the same size.
For this reason, computers simulate the different sizes of
halftone dots with dithering. Dithering is a process that creates
different sized "cells" for each shade of gray by clustering
groups of dots that are the same size.
Dithering makes it possible to reproduce a continuous-tone
image with different gray levels, but it reduces the effective
resolution of your printer. The resolution on an ImageWriter
printer would be too low for quality mass reproduction.
With a 300 dot per inch laser printer, you can produce a
barely acceptable halftone image. With a 2,540 dot per inch
laser imagesetter, you can produce halftones with 256 gray
levels at 150 lines per inch resolution. The chart below shows
the relationship between gray levels and resolution.
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Gray Levels Chart
Halftone
Resolution

Lines Per Inch

Printer Resolution
Dots Per Inch

300

600

1270

2540

50

36

144

256

256

75

16

64

256

256

100

9

36

161

256

120

6

25

112

256

150

4

16

72

256

Note: The Cells Per Inch option in the MacVision Print dialog

box is the equivalent of specifying how many lines per inch a
Postscript halftone should use.

MacVision Halftones
With MacVision, you can produce halftones in two ways. If
you have a Postscript printer, you can specify Postscript
Halftone options on the MacVision Print dialog box.
Postscript Halftone options only change the way the image
appears in print. Since the saved image file stays the same,
you can try the different Postscript Halftone options and easily
return to the original image.
Note: Halftone information is used when MacVision saves a

file in the EPSF format.
You can also choose a Halftone pattern from the Halftone
submenu on the Style menu. These halftone patterns affect the
image on the screen as well as in print. An image file is
unchanged by these halftone patterns if you save with the
-
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RIFF or TIFF file formats. If you save an image in the RIFF or
TIFF formats, you can try different halftone patterns to find the
one that works best. And you can redisplay the RIFF or TIFF
image in grayscale at any time by choosing Grayscale from
the Style menu.
If you use a non-Postscript printer, you can apply the
Halftone patterns on the Style menu to reproduce images as
halftones. If you have a Postscript printer, select Postscript
halftone options by applying a Halftone pattern on the Style
menu. The Postscript Halftone options permit finer halftoning.

-
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Appendix E

File Formats

MacVision can translate digitized images into files in the
formats used hy major puhlishing, graphic arts, presentation
and image processing applications for the Macintosh.
MacVision can save files in the Raster Image File Format
(RIFF), Tag Image File Format (TIFF Bitonal and Grayscale),
Encapsulated Post Script File (EPSF), PICT 1, PICT 2 and
MacPaint formats. MacVision can open files in the RIFF and
TIFF formats.

Files and File Formats
RIFF Files
MacVision uses the RIFF file standard as its native file format.
You can open RIFF files with ImageStudio to edit or enhance
the image.
You can save RIFF files in 4-, 6- or 8-hit formats in either
compressed or non-compressed form.
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TIFF Files
You can save TIFF files with Intel or Motorola byte ordering.
This option lets you use MacVision TIFF files with either the
Apple Macintosh (Motorola) or IBM PC (Intel) computers. This
feature is valuable when transferring files into applications
such as Aldus PageMaker, which is available for both the
Macintosh and IBM. You can open TIFF files with Digital
Darkroom to edit or enhance the image.
TIFF files may be saved in 4-, 6- or 8- bit formats. Dithered
bitmap images may also be saved in the TIFF format.

RI FF File Compression
RIFF files saved with MacVision may be full-size or
compressed. Compression reduces the size of the files by
about one-third. For example you can save a 300K byte image
in a compressed file using about ZOOK bytes. If an image has a
lot of detail, less compression is possible. For example, a dark
image can be compressed more than a floral scene.

Encapsulated Postscript Files
You can save images in the Encapsulated Postscript (EPSF)
format to print them on Postscript-compatible output devices
such as the Apple LaserWriter or Linotronic typesetters. You
can open EPSF files with graphics applications such as
SuperMac PixelPaint Professional to edit or enhance them.
A typical Macintosh EPSF file contains a PICT resource along
with an encoded version of the raw grayscale data. This
information is used for screen display prior to printing.

EPSF is saved with PostScript halftone screen density
and rotation angle values selected in the MacVision
Print dialog box. You can select Mac or PC byte ordering.
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PICT/Version 1
The PICT file standard was introduced by Apple as a format
for saving MacDraw images with two levels of brightness
(black and white.) You can open PICT files with MacDraw
and other drawing applications such as Canvas or SuperPaint.

PICT/Version 2
PICT2 is an extended version of the PICT format. Apple
developed PICT2 to handle grayscale and color images.
MacVision can create PICT2 files when you are using a
Macintosh II or SE/30 computer. Macintosh Plus or SE
computers display PICT2 files if you have System 6.0.2 or
later; however, you won't see grayscales.

MacPaint Files
Images stored in the MacPaint format contain one unit of
information for each pixel or dot displayed.
You can open these images with most popular paint and
illustrator-type applications to add text, produce line art or
apply special visual effects. The MacVision implementation of
the MacPaint file format produces a 576 by 720 pixel
bitmapped image. This makes loading and editing of image
files in MacPaint and compatible applications easier, although
it crops a small amount from each side of the image.
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File Format Chart
AQQlication
RIFF TIFF* TIFG* PICT PICT2 EPSF Paint
Canvas 2.1
Cricket Paint
Design Studio
Digital Darkroom
Freehand 2.0
Illustrator
ImageStudio 1. 5
PageMaker 3.0
PixelPaint Pro. 1.0
Photoshop
Quark Xpress
ReadySetGo 4.Sa
Streamline
SuperPaint 2.0
•TIFF represents TIFF/Bitonal and TIFG representas TIFF/Grayscale.

...
...
......

...
......
......
......
......
......
...

......
......
......
.........
......

......
......
......
.........
......
...

...
...
...

......
...
...
.........
......
......

...
...
.........
......

......
......
......
.........
......
......

Note: This file format chart lists the file formats currently
supported by several popular Macintosh applications. It is

intended to give you an idea of the kind of formats available
in various software categories. As these products are updated,
the supported file formats may change.

- - - -- -
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Appendix F

Mac Vision
Specifications
Electrical Specifications
Input Video Signal
.._ NTSC (RS-170 or RS-170A) color or monochrome
composite video
.._ RCA standard phono jack input connector

Serial Data Input and Output
.._ Data transfer rate - 223.8 Kbps
.._ Data configuration - 8 data bits
.._ 1 stop bit, no parity
.._ Round DIN connector to Macintosh serial port

Reset Command
The MacVision hardware is reset to the left edge of the video
frame by transmitting a 4 millisecond Break command from
the Macintosh to the digitizer.

------------------ - - - -
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Appendix G

Troubleshooting

Most MacVision problems arise from the video camera and the
cables connecting the camera to the digitizer unit. We suggest
that you use a video monitor to view the output of the camera
when troubleshooting a MacVision installation.
Many video cameras and camcorders have a small video
monitor that is used as the viewfinder. Professional video
cameras generally do not have a built-in monitor and you can
either use a separate TV monitor or rely on your Macintosh
monitor and the options in the Pre• Views dialog box. The
monitor can be connected using a "Y" or "T" connector in the
cable running from the camera to the MacVision digitizer.

No Video Signal
Be sure the MacVision digitizer output plug is firmly inserted
into the modem or printer port on the back of the computer.
Check to see that the proper port has been selected by
choosing Input Options from the Video menu.
If the Watchdog command on the Video menu is turned on
(Disable Watchdog displays), MacVision will alert you if the
cables become loose or disconnected.
If possible, check your AC adaptor to be sure it is putting out
9 volts AC current.
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If the Watchdog command is turned off (Enable Watchdog
displays on the Video menu), you can either turn on the
Watchdog command to check the connections or choose
Pre•Views from the Video menu. If no signal is being
received from the camera when you choose Pre•Views, there
will be a screen message to let you know the application is
receiving no signal. This message verifies that the MacVision
software is working and that the problem is no input video
signal.

Picture Has Fine Vertical Lines
This condition can be caused by the digitizer having reversed
fields in the video frame while scanning. Diagonal lines will
be fuzzy or saw-toothed. Choose Swap Fields from the Video
menu to reverse the fields and clarify the image.

Picture Has Coarse Vertical Lines
This condition can be caused by your Macintosh being
connected to a network that generates system interrupts while
MacVision is scanning. Disconnect the network and make a
few new MacVision images. If the lines are no longer present
the network is most likely the problem.

Scanning While on a Network
For many networks, you can turn off the AppleTalk option
after choosing the Chooser command from the Apple menu.
As soon as you close the Chooser dialog box, the network is
turned off and you can scan a MacVision image.
With other networks such as AppleShare, the AppleTalk
option is disabled. In this case, you should physically
disconnect the network before scanning with MacVision. A
simple way to disconnect a network without unhooking
cables is to add an NB switch.
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An A/B switch is a small box that lets you turn a knob
between the A and B settings. You can set up this A/B switch
box so that the network is connected when the knob is turned
to A and disconnected when you select B. Then, when you
need to scan an image, just turn the knob to the B setting and
after you finish, turn it back to A.

Image Appears Dark
Adjust Brightness to increase the white level of the image.

Image Appears "Flat" Due To Lack Of Contrast
Adjust the Contrast control while using QuickView.

Image Appears "Grainy"
Adjust the lighting on the subject. Go to the Style menu and
choose Grayscale rather than Halftone.

Does MacVision work with still video cameras?
Yes, MacVision works with still video cameras. However,
many of the consumer-level still video cameras only send a
video signal in the field mode, as opposed to most video
cameras and higher-end still video cameras, that send a video
signal in full frame mode (two fields of information).
With field mode, MacVision receives only half the information
it usually receives. Thus the image may appear out of focus or
otherwise distorted.

Monitor doesn't display grayscale
Macintosh Plus and SE monitors and some other monitors are
unable to display grayscale images. They only display black
and white. Check the Monitor option by choosing Control
Panel from the Apple Menu to find out how many gray levels
your monitor can display.
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MacVision automatically adjusts to black and white monitors
by halftoning the image to show the gray levels as patterns of
black and white dots. When an image is displayed in halftone
patterns the quality is reduced. Also, the Grayscale command
is dimmed in the Style menu since it cannot be used with a
black and white monitor.
MacVision stores images with grayscale information, so even if
you cannot see grayscale on your particular monitor, you can
print grayscale images and display grayscale files on a monitor
that supports grayscale.

How do I connect MacVision to my Mac 128K,
512K or 512KH
The MacVision software will not run on these machines as the
minimum memory requirement for MacVision is 900K RAM.
These three machines do not have enough RAM to run
MacVision.

Does MacVision have OCR capabilities?
MacVision is designed to digitize images. The MacVision
software does not have character recognition capabilities.
MacVision can provide an image capable of being read by
OCR software if the image is digitized with high resolution
equipment and with high quality lighting and set-up.

Monitor does not display color
MacVision will accept a color video signal as its video source.
However, MacVision only displays black and white or
grayscale on the monitor. The colors are filtered out to
facilitate digitizing.
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Scrambled image displayed on monitor
This condition indicates there may be a problem with the
MacVision hardware. Occasionally resistors, capacitors and/or
diodes go bad. Call Koala Technologies customer support for
information about repairs.

Slow scan that stops before completion
Same as scrambled image.

What kind of resolution can I expect from
MacVision?
First, consider the video source. The higher the resolution of
your video source the better the performance of MacVision.
Second, MacVision software provides four levels of quality for
capturing images. Each level produces a different resolution.
For more information about these capture modes, see the File
New topic in the Chapter 4, Reference.
Third, the type of printer you use determines the printed
resolution.

Insufficient memory to run MacVision
If your Macintosh has 2MB or more of Random Access
Memory (RAM), you can use MacVision with MultiFinder. If
your computer has lMB of memory, you must use
MacVision with the Finder.

If you decide to use MacVision with MultiFinder, specify the
amount of RAM before launching the application. Do this by
clicking the application icon once and choosing Get Info
from the File menu. You can change the current application
memory size at the bottom of the Get Info dialog box.
MacVision requires 900K in RAM - 1,SOOK is recommended.
By increasing the application memory size, you will be able to
open more windows and images while running MacVision.
Appendix G Troubleshooting
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Glossary

The following is a list of selected terms used in the fields of
video, computer graphics, graphic arts and printing.

analog signal - A signal such as that produced by a TV
camera which varies in voltage over time in a continuous
manner.
Bit - An acronym for Binary digiT. A single piece of
information such as a zero or one. See also byte.
bit image - A collection of bits in memory representing a
two-dimensional surface. The screen is a visible example of a
bit image. See also pixel image.
bitmap - A set of bits representing the position and binary
state of a corresponding set of items. See also bit image.
bitonal -

Black and white.

brightness control - A control that sets the overall level of
intensity or brightness of a displayed image.
byte - A group of 8 bits. The byte is a common unit of
measure for memory and file sizes. A single byte can
represent any of 256 different characters or 256 discrete levels
of brightness.
CCD- Charge Coupled Device. A semiconductor device

used in TV cameras to convert light into an electrical signal.
The CCD output voltage is an analog representation of the
<;lossary
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brightness. The CCD output is sampled and converted into a
digital representation of the image.

composite video - An analog video signal containing
brightness, color and synchronization information. Most video
cameras and VCRs produce a composite video output.
continuous-tone image - An image with an infinite
number of gray levels. A photograph (a good example of a
continuous-tone image) contains as many as one million tones
or shades of gray.
contrast control - A control that sets the upper and lower
limits on the brightness of a displayed image. When the upper
and lower limits are close together, the image has low
contrast. With a much wider range of possible dark and light
values, the image has a higher contrast.
digitized sample - The digital bit pattern representing the
brightness level of a sample of an analog video image.
MacVision creates 8 bit digital samples providing 256 levels of
brightness information.
digitizer - Any device that creates a digital representation of
a continuous-tone image. MacVision is a video digitizer
because it creates a digital representation of an analog video
image.
dithering - The process of grouping pixels or dots of the
same size into clusters to form halftone dots of various sizes
and shapes. This is done to produce shades of gray in an
image printed on a computer screen or printer.
EPSF format - Encapsulated Postscript File format. A file
format that is generated by applications that produce
Postscript output. An EPSF file contains a low resolution
dithered bitmap derived from the original digitized image
along with an encoded version of the raw grayscale data. A
Postscript-compatible printer can reconstruct the EPSF image
as a high resolution halftone output.
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f"tlter - A term derived from photography. Optical filters
change the appearance of a photograph by emphasizing or ·
reducing certain wavelengths of light. The same types of
effects can be achieved with digital images using electronic
filters. Electronic filters can also be used to sharpen or blur an
image and can be applied to selected portions of the image.

gray level file format- File formats such as RIFF, TIFF and
EPSF that permit saving gray level information.
graymap - The relationship between the input grayscale
information of an image and the output grayscale.
Manipulating the graymap can produce a wide range of image
effects.
grayscale - The presentation of an image using a discrete
number of gray levels rather than continuous tones.
MacVision digitizes images into a grayscale of 256 levels.
halftone - A lithographic process that converts a
continuous-tone image such as a video frame or a photograph
into a pattern of dots for printing. Halftones are created by
using screens with a fixed number of dots per inch. Gray
values are represented by using various dot sizes with larger
dots giving darker gray values.
halftone pattern - The specific way pixels are arranged to
form halftone dots. There are several popular dither patterns
in use. One of the most widely used is the 8 by 8 dither matrix
pattern used by Postscript. MacPaint is another commonly
used dither pattern standard.
horizontal scan line - One of the 480 horizontal lines
traced on the screen of a TV monitor by the raster scan
process. MacVision takes 640 samples of each horizontal scan
line to form a digital image.
interlace - In the NTSC TV standard two 240 line fields are
generated and then combined or interlaced to produce a
single 480 line frame.

< ;lossary

H-3

landscape - A display or printing mode in which the long
dimension is horizontal.
moire· - A grid-like or checkerboard pattern of distortion
sometimes seen when an image is reduced or when the fields
in a video image are reversed during scanning.
MacPaint files - Bitmapped images saved in the Paint file
format for transfer into MacPaint and compatible paint or
draw programs for editing and special effects.
NTSC -

Television standard used in the United States.

page description language - A computer language that
has commands for creating text and graphics images on a
page. Postscript is one of the most widely used page
description languages.
paint program - A type of graphics application that
produces and stores images as bitmaps.
PAL -

Television standard used in Europe.

PICT format -

A file format used to store and transfer
images that are compatihle with the MacDraw drawing
application among others.

PICT 2 format -

An extension of the PICT file format to
include color and shades of gray. Used with Apple Color
QuickDraw screen and printer page description language.

pixel - Picture element. The unit of resolution for scanning
and screen displays. Pixels can contain simple black & white
information or a bit pattern for shades of gray. An 8-bit pixel
contains information for up to 256 shades of gray.
pixel image - A multiple-bit-per-pixel image. Color
QuickDraw can handle pixel images to produce shades of
gray or colors on a screen or printer.
portrait - A display or printing mode in which the long
dimension is vertical.
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posterization - An image processing technique that limits
the number of gray shades in an image to produce a high
contrast, poster-like effect. Posterizing is done by changing
the Transfer graymap so that a group of input shades are
translated in a single output shade.
PostScrlpt - A page description language created by Adobe
Systems to control the final images printed by laser printers,
Linotronic typesetters and other Postscript compatible
printers. Postscript page and image information can be stored
in Encapsulated Postscript (EPSF) files.
raster - The method by which TV images are generated and
displayed. A continuously moving electron beam scans back
and forth across the face of the picture tube moving down the
screen. In the NTSC standard, the result is a frame or image
consisting of 480 horizontal lines.
resolution - In image scanning the number of samples
taken of the image. MacVision creates and displays a digital
image with a resolution of 640 by 480 pixels. Other forms of
resolution used in graphics are in relation to a physical
standard and include the 72 DPI, dot per inch, resolution of
the Macintosh screen and the 300 DPI resolution of a
LaserWriter printer.
Raster Image File Format. An image file
format standard that allows for storage of up to 256 shades.
This format also allows compression of image data to save file
storage space.
RIFF format -

rotate - To revolve an image or object around a given point.
scale - To change the size of an image or object either
vertically, horizontally or both.
scanning - A general term for document or image digitizing.
screen - A piece of glass or film containing dots used in
graphic arts to create halftones from a continuous tone image
such as a photograph. The screen breaks the image into
halftone dots or lines for reproduction. With electronic images
< ,lossary
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the halftone effect is created by Postscript commands that
control the output printer. Screens are defined by their
percent density and angle of rotation.

TIFF format - Tagged Image File Format. A file format
standard for graphics images that uses tags to identify graphics
elements. The TIFF format may be used to transfer image files
between computers using the Macintosh/Motorola standard
and those using the IBM/Intel standard for byte ordering.
video frame - A video frame is the unit of image output of a
video camera. A frame contains an interlaced raster image of
480 scan lines with each line containing analog brightness
information. A video camera produces video frames at a rate
of 30 per second. The video frame rate is the equivalent of a
movie camera photographing a scene at a frame speed of 30
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Index

A
A to D converter A-4
A/B switch G-2, G-3
About MacVision® 4-1
actual size view 4-35
Adjust B & C 3-2, 4-30
analog images A-1
analog-to-digital converter A-4
Apple menu 4-1
AppleTalk networks 1-5
Apply Settings (graymap) 4-20
Arrow Pointer 4-23

B
B & C Tool 4-14, 4-15
bitmaps D-1- D-7
Brightness 4-14 - 4-16, 4-18, 4-30
Brightness
& Contrast Graymap 4-18
knob 4-29, 3-2, 3-3
Byte Ordering 3-9, 4-10

c

cables

1nclPx

2-1, 2-3, G-1

1-1

camera,
still video B-5
video B-1, B-2
Capture Modes 4-5, 4-6
cells, halftone 4-12, D-5
charged coupled device B-2
Clear 4-3
Clipboard Copy options 4-3
Close 4-8
coaxial cable 1-3
Color QuickDraw D-1, D-2
color
cameras 1-3 model, HSB and RGB
wheel 4-26
Compression 3-9, 4-10, E-2
connector,
DIN 2-1
TorY 2-2
Contrast 4-14 - 4-16, 4-18, 4-29, 4-31
Contrast knob 3-2, 3-3, 4-29
Copy 4-3
Copy As... 4-3
Copy
options, Clipboard 4-3
stand C-3
Crop To Selection 4-4
Crosshair 4-2
Cursor,
Arrow Pointer 4-23
Crosshair 4-2
Grabber 4-13
Cut 4-2

4-25

D
dark image G-3
Default
Posterization 4-20
Settings (graymap) 4-20
Transfer Graymap 4-19
digital images A-1
digitizer, ~acVision 3-2, 3-3, 4-29
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digitizing process A-3 - A-5
DIN connector 2-1
Disable/Enable Watchdog 2-3, 4-28
dithering D-5
documents, maximum open 4-8
dot shapes 4-12
dots, halftone D-3 - D-5
Draw Tool 4-16

E
Edit menu 4-2
electrical specifications F-1
Enable/Disable Watchdog 2-3, 4-28
Encapsulated Postscript files E-2
Enhanced capture mode 4-6

F
Fetch Settings (graymap) 4-20
Field capture mode 4-6
fields 4-5, 4-33, 4-34, A-3, G-2
File
Creator 4-8
Format 4-10
menu 4-4
Type 4-8
compression E-2
formats 3-8, 4-8, E-1 - E-4
fill light C-2
Fit To Window/Show Actual Size
fixed lens B-3
flat
art C-3
image G-3
Focus Zoom
2: 1 3-5, 4-32
4: 1 3-6, 4-32
focus
an image 3-5
box 3-4

Index
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formats, file 3-8, 4-8, E-1 - E-4
frame, video 4-33, A-3
freeze frame B-4
fullframe B-5

G
Grabber 4-13
grainy image G-3
gray
level 4-6, D-4
value input and output 4-17
Graymap
menu 4-14
tool, Transfer 4-17, 4-18
grayscale 4-23, D-1 - D-7
grayscale screen D-2

H
Halftone submenu 4-24
halftone
cells D-5
dots D-4, D-5
options, PostScript 3-10
patterns 4-24
photographs D-4
resolution chart D-6
screen D-4
halftones D-1 - D-7
hardware considerations, Macintosh
Help... 2-3, 4-1
Hide/Show
B & C Tool 4-14, 4-15
Posterization Tool 4-19, 4-20
Transfer Tool 4-15 -4-18
high light C-2
HSB color model 4-25
Hue Setup... 4-24

1-4
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I
image
window name 4-35
sensors B-2
image,
dark G-3
flat G-3
grainy G-3
MacVision window 4-22
printing 3-9
saving 3-8
scanning 3-6, 3-7
solarize an 4-21
imagesetters D-5
ImageWriter D-3, D-5
Input
Gray 4-17
Options... 3-1, 4-28
signal G-2
video signal F-1
input, serial data F-1
installing MacVision
hardware 2-1
software 2-2
interlaced fields 4-33, 4-34, A-3
Interpolated capture mode 4-6

K
key light C-2
knob, brightness and contrast

3-2, 3-3, 4-29

L
LaserWriter 3-11, D-3, D-5
lenses B-3
lighting C-1 - C-3
lines, vertical G-2

Index
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M
Macintosh hardware considerations
MacPaint files E-3
macro lens B-3
MacVision
digitizer 3-2, 3-3, 4-29
image window 4-22
Print dialog box 3-10
memory 1-3, 1-4
menu,
Apple 4-1
Edit 4-2
File 4-4
Graymap 4-14
Style 4-23
Video 4-27
View 4-34
Modem port 4-28
moire' patterns 1-2
monitor, video B-4
monitors 1-4
monochrome screen D-2
MultiFinder 1-4
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N
Negate Transfer 4-19, 4-26
Negative, photographic 4-19, 4-26
networks 1-4, G-2, G~3
New 3-7, 4-5
non-Postscript printer 3-11, D-3
Normal capture mode 4-6
NTSC 1-2, 3-1, 4-29, A-3
NTSC video frame A-2

0
Open 4-7
Output Gray 4-17
output, serial data F-1
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p
Page Setup... 3-9, 4-11
PAL 3-1, 4-29
Paste 4-3
photographs, halftone D-4
PICT and PICT2 E-3
pixel A-4, D-1
Pixel Depth 3-7, 3-9, 4-6, 4-10
Plot Tool 4-16
Pointer 4-23
Posterization Tool 4-19, 4-20
Posterization, Default 4-20
Postscript 1-3
Postscript Halftone Options 3-10, 4-11, 4-12
Pre•Views 3-2, 4-29
Print
dialog box, LaserWriter 3-11
dialog box, MacVision 3-10
Options 4-11
Selection 4-12
quality D-3
printer
port 4-28
resolution chart D-6
printers 1-3, 3-11, D-3
printing an image 3-9
Print... 4-11

Q

quality loss B-5
Quick View 3-4, 4-31
QuickDraw D-1, D-2
Quit 3-12, 4-13

R
raster scanning A-2
RCA plug 1-3, 2-1
recorder, video B-4
reduced size view 4-35

Index
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requirements 1-3
reset command F-1
resolution D-3 - D-6
RGB color model 4-25
RIFF files E-1, E-2
RS-170 or RS-170A 1-3

s
samples A-3, A-4
Save 3-8, 4-8
Save As... 3-8, 4-9
scan lines 4-34, A-2
scanning
an image 3-6, 3-7
while on a network G-2, G-3
screen
angle 4-12
displays D-1, D-2
screen,
grayscale D-2
halftone D-4
monochrome D-2
Select All 4-4
Selection, crop 4-4
sensors, image B-2
sepia image 4-26
Serial
Port 3-1, 4-28
bit stream A-5
data input and output F-1
Settings,
Apply (graymap) 4-20
Default (graymap) 4-20
Fetch (graymap) 4-20
Store (graymap) 4-20
Shadow 4-27
Shape 4-27
Sharpen 4-27
Shave 4-26
Show Actual Size/Fit To Window
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Show/Hide
B & C Tool 4-14, 4-15
Posterization Tool 4-19, 4-20
Transfer Tool 4-15 - 4-18
Smoothen 4-26
Soften 4-27
solarize an image 4-21
specifications, electrical F-1
starting MacVision 2-2
still video cameras 1-3, B-5
Store Settings (graymap) 4-20
Style menu 4-23
submenu, Halftone 4-24
Swap Fields 4-33
switch, A/B G-2, G-3

T
T connector 2-2
three dimensional art C-2, C-3
TIFF files E-2
Transfer Graymap Tool 4-15 -4-18
tripod C-3
TVvideo A-2
two dimensional art C-2, C-3

u

Undo

4-2

v
vertical lines G-2
videcon B-2
Video menu 4-27
Video
Standard 4-29
camera, still B-5
cameras B-1, B-2

Index
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Video
digitizer A-2
frame 4-33
input device B-1
monitor B-4
out 1-3, 2-1
quality cables 2-1
recorder B-4
standard 3-1
video, input signal F-1
View menu 4-34

w

Watchdog, Enable/Disable
window,
image name 4-35
MacVision image 4-22

2-3, 4-28

y
Y connector

2-2

z
zoom lens
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